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Overview: BlackBerry Enterprise Server 1

The BlackBerry® Enterprise Server is designed to be a secure, centralized link between an organization's wireless network,
communications software, applications, and BlackBerry devices. The BlackBerry Enterprise Server integrates with your
organization's existing infrastructure, which can include messaging and collaboration software, calendar and contact information,
wireless Internet and intranet access, and custom applications, to provide BlackBerry device users with mobile access to your
organization's resources.

The BlackBerry Enterprise Server supports AES and Triple DES encryption to protect and ensure the integrity of wireless data
that is transmitted between the BlackBerry Enterprise Server components and BlackBerry devices. You can select from more than
450 IT policy rules that you can configure to control the features of the BlackBerry devices that are used in your organization's
environment.

The BlackBerry Enterprise Server supports several optional components and configurations to meet your organization's
requirements. The BlackBerry Collaboration Service integrates with supported third-party instant messaging servers to permit
users to access your organization's instant messaging system from their BlackBerry devices using the BlackBerry instant
messaging client. The BlackBerry MDS Integration Service supports custom application development and distribution. You can
configure the BlackBerry Enterprise Server and the BlackBerry Enterprise Server components to support high availability to
enhance the consistency and reliability of your organization's environment.

You can manage the BlackBerry Enterprise Server, BlackBerry devices, and user accounts using the BlackBerry Administration
Service, a web application that is accessible from any computer that can access to the computer that hosts the BlackBerry
Administration Service. You can use the BlackBerry Administration Service to manage a BlackBerry Domain, which consists of
one or more BlackBerry Enterprise Server instances and remote components that use a single BlackBerry Configuration Database.

Upgrade Guide Overview: BlackBerry Enterprise Server
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Planning a BlackBerry Enterprise Server upgrade 2

If your organization's environment includes only one BlackBerry® Enterprise Server at version 4.0 SP7 or 4.1 SP3 or later, you
can upgrade the BlackBerry Enterprise Server to the latest version by overwriting it or by installing the BlackBerry Enterprise
Server on a different computer and moving the user data to the upgraded BlackBerry Enterprise Server.

If your organization's environment includes more than one BlackBerry Enterprise Server at version 4.1 SP3 or later, you can
upgrade each BlackBerry Enterprise Server instance to the latest version in phases to reduce the risk to your organization's
environment and minimize the number of users that are affected at the same time.

For information about upgrading more than one BlackBerry Enterprise Server, see the BlackBerry Enterprise Server Upgrade
Planning Guide.

Replacing the BlackBerry Manager with the BlackBerry Administration
Service
In BlackBerry® Enterprise Server versions later than version 4.1, the BlackBerry Administration Service replaces the BlackBerry
Manager as the BlackBerry Enterprise Server component that you use to manage the BlackBerry Enterprise Server and BlackBerry
device users.

During the BlackBerry Enterprise Server upgrade process, the setup application removes the BlackBerry Manager. If you installed
a standalone BlackBerry Manager, you can remove the BlackBerry Manager after you install the BlackBerry Administration Service.

After the BlackBerry Enterprise Server upgrade process completes, you must create administrator accounts for the administrators
in your organization and provide the administrators with new login information and the BlackBerry Administration Service web
address. If you try to run the BlackBerry Manager, it displays the "DB version greater than maximum currently supported" message
and closes.

Synchronizing data over the wireless network automatically
When you upgrade the BlackBerry® Enterprise Server, the BlackBerry Synchronization Service sends updated service books to
the BlackBerry devices that can synchronize data over the wireless network. BlackBerry® Device Software versions 4.0 and later
can synchronize data automatically if the BlackBerry Enterprise Server is running.

If the data does not synchronize automatically, you must use the BlackBerry Administration Service to resend the service books
and synchronize the data.

Upgrade Guide Planning a BlackBerry Enterprise Server upgrade
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Upgrade implications for the BlackBerry Configuration Database
When you upgrade the BlackBerry® Enterprise Server to the latest version, you must also upgrade the BlackBerry Configuration
Database to the latest version. To upgrade the BlackBerry Configuration Database, you can use the setup application to install
or upgrade BlackBerry Enterprise Server components. The installation or upgrade process upgrades the BlackBerry Configuration
Database automatically so that the database and components run the same version. If you do not want to use the setup application
to upgrade the BlackBerry Configuration Database, you can run the database upgrade scripts on the database server.

You cannot manage the BlackBerry Enterprise Server until you install the BlackBerry Administration Service version that is the
same as the BlackBerry Configuration Database version or upgrade the BlackBerry Administration Service so that it is the same
version as the BlackBerry Configuration Database.

The latest BlackBerry Enterprise Server version supports MSDE but you might want to move an MSDE database such as a
BlackBerry Configuration Database from MSDE to a version of Microsoft® SQL Server® that Microsoft fully supports. To upgrade
a BlackBerry Configuration Database and move it from MSDE to Microsoft SQL Server, you should create a copy of the BlackBerry
Configuration Database, move the copy to Microsoft SQL Server, and then upgrade the BlackBerry Configuration Database on
the Microsoft SQL Server to the latest version.

Supported BlackBerry Enterprise Server versions that you can upgrade
You can upgrade the following BlackBerry® Enterprise Server versions to the latest BlackBerry Enterprise Server version:
• BlackBerry Enterprise Server version 5.0
• BlackBerry Enterprise Server version 4.1 SP3 or later
• BlackBerry Enterprise Server version 4.0 SP7 if there is only one BlackBerry Enterprise Server instance in your organization's

BlackBerry Domain. If there is more than one BlackBerry Enterprise Server instance in your organization's BlackBerry Domain,
you must upgrade to BlackBerry Enterprise Server version 4.1 SP3 or later before upgrading to the latest version.

Upgrade Guide Upgrade implications for the BlackBerry Configuration Database
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Hardware requirements: BlackBerry Enterprise Server 3

The following are requirements for a BlackBerry® Enterprise Server and the BlackBerry Enterprise Server components that you
install on a single computer, and excludes the BlackBerry Collaboration Service and the BlackBerry MDS Integration Service. The
requirements are for a BlackBerry Enterprise Server environment that includes users that receive 100 to 200 email messages
each day.

You can improve the performance and reliability of the BlackBerry Enterprise Server by installing the BlackBerry Enterprise Server
components on multiple computers. If your BlackBerry Enterprise Server environment supports up to 1000 users, install the
BlackBerry Configuration Database on a computer that is separate from the computer that hosts the BlackBerry Enterprise Server.
If your BlackBerry Enterprise Server environment supports up to 2000 users, install the BlackBerry Configuration Database and
the BlackBerry Administration Service on computers that are separate from the computer that hosts the BlackBerry Enterprise
Server.

Item Requirement

BlackBerry Enterprise Server that

supports up to 200 users
• Single processor, 2.0 GHz Intel® Xeon® (two processors recommended)

• 2 GB of memory

• 2 drives, RAID 1

BlackBerry Enterprise Server that

supports up to 500 users
• Two processors, 2.0 GHz Intel Xeon

• 2 GB of memory

• 2 drives, RAID 1

BlackBerry Enterprise Server that

supports up to 1000 users
• Two processors, 2.0 GHz Intel Xeon

• 3 GB of memory

• 2 drives, RAID 1

BlackBerry Enterprise Server that

supports up to 2000 users
• Two processors, 2.8 GHz Intel Xeon or two processors, 1.86 GHz Intel Xeon

5100 Series (Dual Core)

• 4 GB of memory

• 2 drives, RAID 1 or 4 drives, RAID 1+0

Upgrade Guide Hardware requirements: BlackBerry Enterprise Server
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System requirements 4

For information about calculating hardware requirements, visit www.blackberry.com/go/serverdocs to see the BlackBerry
Enterprise Server Capacity Calculator and BlackBerry Enterprise Server Performance Benchmarking Guide.

System requirements: BlackBerry Enterprise Server

Item Requirement

operating system Any of the following operating systems:

• Windows Server® 2003 SP2 (32-bit or 64-bit)

• Windows Server 2003 R2 SP2 (32-bit or 64-bit)

• Windows Server 2008 SP2 (32-bit or 64-bit)

Microsoft® Exchange system tools Any of the following system tools:

• Microsoft Exchange 2003 SP2 System Manager

• Microsoft Exchange Server MAPI client and CDO 1.2.1

To support Microsoft Exchange 2010, you must install Microsoft Exchange Server

MAPI client and CDO 1.2.1 version 6.5.8146.0 or higher.

For more information about installing MAPI and CDO patches on your

organization's BlackBerry® Enterprise Server, visit http://support.microsoft.com to

read article 917481.

Microsoft Exchange organization of the

system tools for the messaging server

The same Microsoft Exchange organization that the messaging server uses

CDO library To support the latest version for Microsoft Exchange in your organization's

environment, the latest version of the CDO library that applies to that version

Unicode support for calendars To support Microsoft Exchange 2003, the following Microsoft hotfixes:

• 913643 on the messaging server

• 923537 on the computer that hosts the BlackBerry Enterprise Server

database conditions for the BlackBerry

MDS Integration Service

A database server that hosts the BlackBerry Configuration Database

static IP address for the computer To install the BlackBerry MDS Integration Service or the BlackBerry Administration

Service in a pool, a static IP address for the computer that hosts the component

Upgrade Guide System requirements
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Item Requirement

browser Windows® Internet Explorer® 6.0 to 8.0 with language preferences configured to

display encoded web pages

media player To support audio attachments, Windows Media® Player 9 or later

network proximity A high-speed, switched connection between the BlackBerry Enterprise Server and

messaging servers

monitoring To support the BlackBerry Monitoring Service, the SNMP service must be running

System requirements: BlackBerry Administration Service and BlackBerry
Web Desktop Manager
The following system requirements apply when you install the BlackBerry® Administration Service and BlackBerry® Web Desktop
Manager on a computer that is separate from the computer that hosts the BlackBerry® Enterprise Server.

Item Requirement

operating system Any of the following operating systems:

• Windows Server® 2003 SP2 (32-bit or 64-bit)

• Windows Server 2003 R2 SP2 (32-bit or 64-bit)

• Windows Server® 2008 SP2 (32-bit or 64-bit)

• Microsoft® hotfix 955839 installed on the computer that hosts the BlackBerry

Administration Service and BlackBerry Web Desktop Manager

memory A minimum of 1.2 GB of memory

browser Windows® Internet Explorer® version 6.0 to 8.0 with the following settings:

• language preferences configured to display encoded web pages

• the BlackBerry Administration Service and BlackBerry Web Desktop Manager

web sites assigned to the local intranet or trusted sites security zone

System requirements: BlackBerry Enterprise Server databases

Item Requirement

database management system Any of the following database management systems:

Upgrade Guide System requirements: BlackBerry Administration Service and BlackBerry Web Desktop Manager
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Item Requirement

• MSDE 2000 SP3

• Microsoft® SQL Server® 2005 SP3 (32-bit or 64-bit)

• Microsoft SQL Server 2005 Express Edition SP3

• Microsoft SQL Server 2008 SP1 (32-bit or 64-bit)

• Microsoft SQL Server 2008 Express Edition SP1 (32-bit or 64-bit)

For all versions of the Microsoft SQL Server earlier than Microsoft SQL Server 2005 SP3,

Microsoft Security Bulletin MS09-004 (for more information, visit http://

technet.microsoft.com to read article KB960082).

collation setting The following conditions on the database server:

• collation set to default case-insensitive

• BlackBerry® Configuration Database collation set to default case-insensitive

• BlackBerry® database notification system and Microsoft SQL Server server collation

must be the same

• default collations are recommended though non-default collations are supported

(for more information, visit http://technet.microsoft.com to read articles KB04785

and KB15534)

remote database conditions TCP/IP network protocols turned on

database mirroring To support database mirroring for the BlackBerry Configuration Database or BlackBerry

MDS Integration Service database, the following conditions:

• the database server must be Microsoft SQL Server 2005 SP3 Enterprise Edition or

Standard Edition (32-bit or 64-bit), Microsoft SQL Server 2008 Enterprise Edition

or Standard Edition (32-bit or 64-bit), or Microsoft SQL Server 2008 SP1 Enterprise

Edition or Standard Edition (32-bit or 64-bit)

• the database server that hosts the mirror database must use the same version and

build as the principal database

• a separate database server for the mirror database

• static port with the same port number for both database servers

• Microsoft SQL Server Browser running on both database servers

database transactional

replication

To support database transactional replication for the BlackBerry Configuration Database

or BlackBerry MDS Integration Service database, the following conditions:

• the database server must be Microsoft SQL Server 2005 SP3 or later

Upgrade Guide System requirements: BlackBerry Enterprise Server databases
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Item Requirement

• the database server that hosts the replicated database must use the same version

and build as the primary database

System requirements: BlackBerry Attachment Service
The following system requirements apply when you install the BlackBerry® Attachment Service on a computer that is separate
from the computer that hosts the BlackBerry® Enterprise Server.

Item Requirement

operating system Any of the following operating systems:

• Windows Server® 2003 SP2 (32-bit or 64-bit)

• Windows Server 2003 R2 SP2 (32-bit or 64-bit)

• Windows Server® 2008 SP2 (32-bit or 64-bit)

media player To support audio attachments, Windows Media® Player version 9 or later

browser Windows® Internet Explorer® version 6.0 to 8.0 with language preferences

configured to display encoded web pages

System requirements: BlackBerry Collaboration Service
The following system requirements apply when you install the BlackBerry® Collaboration Service on a computer that is separate
from the computer that hosts the BlackBerry® Enterprise Server.

Item Requirement

operating system Any of the following operating systems:

• Windows Server® 2003 SP2 (32-bit or 64-bit)

• Windows Server 2003 R2 SP2 (32-bit or 64-bit)

• Windows Server® 2008 SP2 (32-bit or 64-bit)

IBM® Lotus® Sametime® IP address of the computer that hosts the BlackBerry® Collaboration Service added to the

CommunityConnectivity document on the IBM Lotus Sametime server

Novell® GroupWise® Messenger SSL authentication turned on for the Novell GroupWise Messenger agents on the Novell

GroupWise Messenger server

Upgrade Guide System requirements: BlackBerry Attachment Service
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Item Requirement

Microsoft® Office Live

Communications Server 2005 or

Microsoft® Office

Communications Server 2007

The latest Microsoft hotfixes installed

System requirements: BlackBerry MDS Connection Service
The following system requirements apply when you install the BlackBerry® MDS Connection Service on a computer that is separate
from the computer that hosts the BlackBerry® Enterprise Server.

Item Requirement

operating system Any of the following operating systems:

• Windows Server® 2003 SP2 (32-bit or 64-bit)

• Windows Server 2003 R2 SP2 (32-bit or 64-bit)

• Windows Server® 2008 SP2 (32-bit or 64-bit)

RSA® Authentication Agent To support enhanced network authentication (optional), RSA® Authentication

Agent version 5.0 for Windows®

memory One of the following:

• if you install a central push server and less than 1000 user accounts, a minimum

of 1024 MB

• if you install a central push server and more than 1000 user accounts, a

minimum of 3 GB

• if you do not install a central push server, a minimum of 512 MB

System requirements: BlackBerry MDS Integration Service
The following system requirements apply when you install the BlackBerry® MDS Integration Service on a computer that is separate
from the computer that hosts the BlackBerry® Enterprise Server.

Item Requirement

operating system Any of the following operating systems:

• Windows Server® 2003 SP2 (32-bit or 64-bit)

Upgrade Guide System requirements: BlackBerry MDS Connection Service
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Item Requirement

• Windows Server 2003 R2 SP2 (32-bit or 64-bit)

• Windows Server® 2008 SP2 (32-bit or 64-bit)

database conditions A database server that also hosts the BlackBerry Configuration Database

static IP address To support the BlackBerry MDS Integration Service pool, a static IP address for the

computer

System requirements: BlackBerry Monitoring Service
The following system requirements apply when you install the BlackBerry® Monitoring Service on a computer that is separate
from the computer that hosts the BlackBerry® Enterprise Server.

Item Requirement

operating system Any of the following operating systems:

• Windows Server® 2003 SP2 (32-bit or 64-bit)

• Windows Server 2003 R2 SP2 (32-bit or 64-bit)

• Windows Server® 2008 SP2 (32-bit or 64-bit)

SNMP The SNMP service running on the computer that hosts the BlackBerry Enterprise Server

browser Windows® Internet Explorer® version 6.0 to 8.0 with the following conditions:

• support for JavaScript®

• cookies turned on

wireless modem To send SMS text messages to BlackBerry devices, an SMS wireless modem connected to

the computer that accepts the AT command set. For more information about SMS wireless

modems recommended for the BlackBerry Monitoring Service, visit www.blackberry.com/

support to read article KB19504.

System requirements: BlackBerry Router
To install the BlackBerry® Router on a computer that is separate from the computer that hosts the BlackBerry® Enterprise Server,
any of the following operating systems:
• Windows Server® 2003 SP2 (32-bit or 64-bit)
• Windows Server 2003 R2 SP2 (32-bit or 64-bit)
• Windows Server® 2008 SP2 (32-bit or 64-bit)

Upgrade Guide System requirements: BlackBerry Monitoring Service
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System requirements: Computers for BlackBerry Web Desktop Manager,
BlackBerry Administration Service, and BlackBerry Monitoring Service users

Item Requirement

operating system Any of the following operating systems:

• Windows Server® 2003 SP2 (32-bit or 64-bit)

• Windows Server 2003 R2 SP2 (32-bit or 64-bit)

• Windows Server® 2008 SP2 (32-bit or 64-bit)

browser Windows® Internet Explorer® version 6.0 to 8.0

browser settings The following conditions must be met:

• the BlackBerry Web Desktop Manager, BlackBerry Administration Service, and

BlackBerry Monitoring Service web sites assigned to the local intranet or

trusted sites security zone

• Microsoft® hotfix 955839 installed on the users' computers to make sure the

correct time zones are displayed

• the following settings turned on to support Microsoft® ActiveX®:

• Automatic prompting for ActiveX controls

• Download signed Microsoft ActiveX controls

• Run ActiveX controls and plug-ins

• Script ActiveX controls marked safe for scripting

• support for JavaScript®

• support for TLS or SSL

• the SSL certificate installed to permit trusted connections with the BlackBerry

Administration Service

• if using Windows Vista, the BlackBerry Administration Service web address

added as a trusted site and Enable protected mode cleared

System requirements: Messaging server
Any of the following messaging servers located in close proximity to where you want to install the primary BlackBerry® Enterprise
Server:

Upgrade Guide System requirements: Computers for BlackBerry Web Desktop Manager, BlackBerry Administration Service, and BlackBerry Monitoring
Service users
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• Microsoft® Exchange 2010 and Microsoft Exchange 2010 Update Rollup 1 (also requires that you install BlackBerry Enterprise
Server 5.0 SP1 MR1)

• Microsoft Exchange 2007 SP2
• Microsoft Exchange 2003 SP2
• Microsoft Exchange mixed environment (Microsoft Exchange 2003 and 2007)

System requirements: Firewall
To install the BlackBerry® Enterprise Server, configure a firewall or proxy firewall with the following conditions:
• exclusive use of port 3101 to open and maintain an outbound, bidirectional TCP/IP connection to an external server
• support for resolving Internet addresses that use DNS
• for proxy firewalls, transparency of the proxy server

System requirements: Instant messaging server
To install the BlackBerry® Enterprise Server, any of the following instant messaging servers:
• IBM® Lotus® Sametime® version 6.5.1 Community Server
• IBM Lotus Sametime version 7.0 Community Server
• IBM Lotus Sametime version 7.5 Community Server
• IBM Lotus Sametime version 8.0 Community Server
• Microsoft® Office Live Communications Server 2005 SP1 Standard or Enterprise
• Microsoft® Office Communications Server 2007 Standard or Enterprise
• Novell® GroupWise® Messenger version 2.0 or later

Supported features and environments

Item Description

virtual environment The BlackBerry® Enterprise Server and BlackBerry Enterprise Server components

support VMware® Infrastructure version 3.5.

enhanced network authentication The BlackBerry Enterprise Server and BlackBerry Enterprise Server components

support RSA® Authentication Agent version 5.0 for Windows®.

SNMP monitoring The BlackBerry Enterprise Server and BlackBerry Enterprise Server components

support the SNMP service.

remote access The BlackBerry Enterprise Server and BlackBerry Enterprise Server components

support remote access by administrators who use Remote Desktop Connection.

Upgrade Guide System requirements: Firewall
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Unsupported environments

Item Description

DMZ The BlackBerry® Enterprise Server and BlackBerry Enterprise Server components,

with the exception of the BlackBerry Router, do not support installation in a DMZ.

messaging server The BlackBerry Enterprise Server and BlackBerry Enterprise Server components do

not support installation on the same computer as the messaging server.

email application The BlackBerry Enterprise Server and BlackBerry Enterprise Server components do

not support the installation of email applications on the same computer.

instant messaging server The BlackBerry Enterprise Server and BlackBerry Enterprise Server components do

not support more than one type of instant messaging server in the BlackBerry

Domain. For example, you cannot install the BlackBerry Collaboration Service for

use with Microsoft® Office Communications Server 2007 and the BlackBerry

Collaboration Service for IBM® Lotus® Sametime® in the same BlackBerry Domain.

BlackBerry database notification system The BlackBerry database notification system does not support installation on a

computer that hosts Microsoft® SQL Server® and runs Windows Server® 2008.

BlackBerry Attachment Service If the BlackBerry Attachment Service is hosted on a computer that uses Windows

Server® 2008, the BlackBerry Attachment Service does not support .mp3 audio files

on BlackBerry devices, and the BlackBerry Attachment Service does not support

any audio file formats on BlackBerry® 7100 Series devices that support CDMA

networks. You must host the BlackBerry Attachment Service on a computer that

uses Windows Server 2003 if you want the BlackBerry Attachment Service to

support .mp3 audio files on BlackBerry devices and all audio formats on BlackBerry

7100 Series devices that support CDMA networks.

Upgrade Guide Unsupported environments
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Preupgrade tasks 5

Configuring a Microsoft Exchange 2010 messaging environment

Create a Windows account that has a Microsoft Exchange 2010 mailbox
You must create a Windows® account with a Microsoft® Exchange 2010 mailbox so that the Windows account can authenticate
with the Microsoft® Exchange Server.

Before you begin: If you want free/busy lookups to work in Microsoft® Outlook® 2003 and earlier, you must configure Microsoft
Exchange 2010 to support Microsoft Outlook 2003 and earlier by creating a public folder database. For more information about
supporting Microsoft Outlook 2003 and earlier, visit http://support.microsoft.com to read article 555851 and visit http://
technet.microsoft.com to read articles 123694, 124270, 397221, and 691120.

1. On the computer that hosts Microsoft Exchange, log in using an administrator account that has the permission to create
accounts.

2. Open the Microsoft Exchange Management Console.

3. Create an account and mailbox that you name BESAdmin.

4. To permit the BlackBerry® Enterprise Server to check if a BlackBerry device user has permission to access a public folder,
assign the Owner permission for all public folders to the administrator account.

After you finish:
• To verify that you created the Windows account, log in to a computer using the Windows account.
• Verify that the Windows account is not a member of the Domain Administrators group in Microsoft® Active Directory®.
• Verify that BlackBerry device users have Read permissions and Visible permissions to public folders.
• To permit BlackBerry device users to check the availability of meeting participants using BlackBerry® Device Software 4.5

or later, configure the Schedule+ Free/Busy information for the system public folder. For more information, visit http://
technet.microsoft.com to read articles 629523 and 691129.

Configure Microsoft Exchange 2010 permissions for the Windows account
1. On a computer that hosts the Microsoft® Exchange Management Shell, open the Microsoft Exchange Management Shell.

2. Type Get-MailboxDatabase | Add-ADPermission -User "BESAdmin" -AccessRights ExtendedRight -ExtendedRights
Receive-As, ms-Exch-Store-Admin.

3. Type Add-RoleGroupMember "View-Only Organization Management" -Member "BESAdmin".
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4. Type Add-ADPermission -InheritedObjectType User -InheritanceType Descendents -ExtendedRights Send-As -
User "BESAdmin" -Identity "CN=Users,DC=<domain_1>,DC=<domain_2>,DC=<domain_3>" where <domain_1>,
<domain_2>, and <domain_3> form the name of the domain.

For example, if the domain name is www.example.com, type www for <domain_1>, example for <domain_2>, and com for
<domain_3>.

After you finish: If you create a new mailbox database for Microsoft Exchange, repeat step 2.

Turn off client throttling in Microsoft Exchange 2010
By default, Microsoft® Exchange 2010 uses client throttling policies to track the bandwidth that each Microsoft Exchange user
consumes and enforce bandwidth limits, as necessary. The policies affect the performance of the BlackBerry® Enterprise Server
negatively, so you should turn off client throttling.
Note:  If you want to turn off client throttling for only the Windows® account that has a Microsoft Exchange mailbox, you can
configure a throttling policy for the Windows account and turn off client throttling for the policy.

1. On a computer that hosts the Microsoft Exchange Management Shell, open the Microsoft Exchange Management Shell.

2. Type Get-ThrottlingPolicy | where {_.IsDefault -eq $true} | Set-ThrottlingPolicy -RCAMaxConcurrency $null.

Increase the maximum number of connections to the Address Book service in Microsoft
Exchange 2010
By default, Microsoft® Exchange 2010 limits the maximum number of connections from the BlackBerry® Enterprise Server to the
Address Book service to 50. To permit the BlackBerry Enterprise Server to run, you must increase the number of permitted
connections to a large value (for example, 100,000).

1. On the computer that hosts the Microsoft Exchange CAS server, in <drive>:\Program Files\Microsoft\Exchange Server\V14
\Bin, in a text editor, open the microsoft.exchange.addressbook.service.exe.config file.

2. Change the value of the MaxSessionsPerUser key to 100000.

3. Save and close the file.

4. Restart the Address Book service.

Configure a management role for Microsoft Exchange Web Services
If you want the BlackBerry® Enterprise Server to use Microsoft® Exchange Web Services to manage calendars on BlackBerry
devices, you must configure a management role for Microsoft Exchange Web Services in Microsoft Exchange 2010.

For more information about configuring the BlackBerry Enterprise Server to use Microsoft Exchange Web Services, see the
BlackBerry Enterprise Server Administration Guide.

1. On a computer that hosts the Microsoft Exchange Management Shell, open the Microsoft Exchange Management Shell.
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2. Type New-ManagementRoleAssignment -Name "BES Admin EWS" -Role ApplicationImpersonation -User
"BESAdmin".

Configure the BlackBerry Enterprise Server to run without public folders
If you did not install any public folders in Microsoft® Exchange, you must configure the BlackBerry® Enterprise Server to run
without public folders by changing a registry key.

1. On each computer that hosts the BlackBerry Enterprise Server, click Start > Run.

2. In the Open field, type regedit.

3. Click OK.

4. Perform one of the following actions:
• If you are running a 32-bit version of Windows®, navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows

Messaging Subsystem\CDO.
• If you are running a 64-bit version of Windows, navigate to HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node

\Microsoft\Windows Messaging Subsystem.

5. If the CDO registry key does not exist, create a registry key that you name CDO.

6. In the CDO registry key, if the DWORD value does not exist, create a DWORD value that you name Ignore No PF.

7. Change the DWORD value to 1.

8. Click OK.

Configuring a Microsoft Exchange 2007 messaging environment

Create a Windows account that has a Microsoft Exchange 2007 mailbox
You must create a Windows® account that has a Microsoft® Exchange 2007 mailbox so that the Windows account can authenticate
with the Microsoft® Exchange Server.

Before you begin: You must configure Microsoft Exchange 2007 to support versions of Microsoft® Outlook® that are earlier
than 2007 by creating a public folder database. For more information about supporting versions of Microsoft Outlook that are
earlier than 2007, visit http://support.microsoft.com to read article 555851 and visit http://technet.microsoft.com to read articles
123694, 124270, 397221, and 691120.

1. On the computer that hosts Microsoft Exchange, log in using an administrator account that has the correct permission to
create accounts.

2. Open the Microsoft Exchange Management Console.

3. Create an account and mailbox that you name BESAdmin.

4. To permit the BlackBerry Enterprise Server to check if a user has permissions for a public folder, assign the Owner permission
for all public folders to the administrator account.
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After you finish:
• To verify that you created the Windows account, log in to a computer using the Windows account.
• Verify that the Windows account is not a member of the Domain Administrators group in Microsoft® Active Directory®.
• Verify that BlackBerry device users have Read and Visible permissions to public folders.
• To permit BlackBerry device users to check the availability of meeting participants in BlackBerry® Device Software 4.5 or

later, configure the Schedule+ Free/Busy information for the system public folder. For more information, visit http://
technet.microsoft.com to read articles 629523 and 691129.

Configure Microsoft Exchange 2007 permissions for the Windows account
1. On a computer that hosts the Microsoft® Exchange Management Shell, open the Microsoft Exchange Management Shell.

2. Perform one of the following actions:
• If you logged in to a Microsoft® Exchange Server 2007, type add-exchangeadministrator "BESAdmin" -role

ViewOnlyAdmin.
• If you logged in to another computer, type get-mailboxserver "<messaging_server_name>" | add-

exchangeadministrator "BESAdmin" -role ViewOnlyAdmin.

3. For each Microsoft Exchange Server 2007 that hosts BlackBerry® device users, type the following command: get-
mailboxserver "<messaging_server_name>" | add-adpermission -user "BESAdmin" -accessrights ExtendedRight -
extendedrights Receive-As, ms-Exch-Store-Admin.

Permit BlackBerry device users to send email messages in a Microsoft Exchange environment
To permit BlackBerry® device users to send email messages, you must configure Send As permissions for the Microsoft® Active
Directory® user object that contains BlackBerry device users. This task describes how to configure the Send As permissions for
the entire Windows® domain but you can also configure the permissions at the user object level or on a container of user objects.

For more information about Send As permissions and the BlackBerry® Enterprise Server, visit www.blackberry.com/support to
read KB04707. For more information about assigning Send As permissions permissions to multiple user accounts, visit
www.support.microsoft.com to read article 912918.

1. Log in to a computer in the Windows® domain as an administrator that has permissions to modify user objects in Microsoft
Active Directory.

2. On the taskbar, click Start > Administrative Tools > Active Directory Users and Computers.

3. On the View menu, click Advanced Features.

4. Right-click the domain root. Click Properties.

5. On the Security tab, click Advanced.

6. Click Add.

7. Type the name of the Windows account that you created (for example, BESAdmin).

8. Click Check Names.
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9. Click OK.

10. In the Apply drop-down list, click User Objects.

11. In the Allow column, select the Send As check box.

12. Click Apply.

13. Click OK.

Configuring a Microsoft Exchange 2003 messaging environment

Create a Windows account that has a Microsoft Exchange 2003 mailbox
You must create a Windows® account that has a Microsoft® Exchange 2003 mailbox so that the Windows account can authenticate
with the Microsoft Exchange messaging server.

1. On any computer in the Windows domain, on the taskbar, click Start > Programs > Microsoft Exchange > Active Directory
Users and Computers.

2. Create an account that has the following attributes:
• Name: BESAdmin
• Group membership: Domain User

3. Create a Microsoft Exchange mailbox for the account.

4. To activate the new mailbox, send a test email message.

After you finish:

If you cannot see the Windows account in the Microsoft Active Directory to verify that you created it, log in to a computer using
the Windows account.

For more information about the Send As permission and the BlackBerry® Enterprise Server, visit www.blackberry.com to read
KB04707.

For more information about assigning the Send As permission to multiple user accounts, visit www.support.microsoft.com to read
article 912918.

Configure Microsoft Exchange 2003 permissions for the Windows account
On each computer that you want to install the BlackBerry® Enterprise Server or BlackBerry Administration Service on, you must
configure the Microsoft® Exchange permissions of the Windows® account that you want to use to complete the installation
process.

Without the correct permissions, the BlackBerry Enterprise Server cannot run after you complete the installation process.

1. Using Microsoft Exchange 2003 System Manager, configure the Exchange View Only Administrator permission with the
minimum access level of Administrative Groups.
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2. At the server level, configure the following permissions:
• Send As
• Receive As
• Administer Information Store

3. To permit the BlackBerry Enterprise Server to check if users have permissions to access a public folder, assign the Owner
permission on all public folders to the account.

After you finish: Verify that the users have Read and Visible permissions to public folders.

Permit BlackBerry device users to send email messages in a Microsoft Exchange environment
To permit BlackBerry® device users to send email messages, you must configure Send As permissions for the Microsoft® Active
Directory® user object that contains BlackBerry device users. This task describes how to configure the Send As permissions for
the entire Windows® domain but you can also configure the permissions at the user object level or on a container of user objects.

For more information about Send As permissions and the BlackBerry® Enterprise Server, visit www.blackberry.com/support to
read KB04707. For more information about assigning Send As permissions permissions to multiple user accounts, visit
www.support.microsoft.com to read article 912918.

1. Log in to a computer in the Windows® domain as an administrator that has permissions to modify user objects in Microsoft
Active Directory.

2. On the taskbar, click Start > Administrative Tools > Active Directory Users and Computers.

3. On the View menu, click Advanced Features.

4. Right-click the domain root. Click Properties.

5. On the Security tab, click Advanced.

6. Click Add.

7. Type the name of the Windows account that you created (for example, BESAdmin).

8. Click Check Names.

9. Click OK.

10. In the Apply drop-down list, click User Objects.

11. In the Allow column, select the Send As check box.

12. Click Apply.

13. Click OK.
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Configure permissions for the Windows account
On each computer that you want to install the BlackBerry® Enterprise Server components on, you must configure permissions
for the Windows® account that you want to use to install the BlackBerry Enterprise Server components and run the services for
the BlackBerry Enterprise Server.

Without the correct permissions, the BlackBerry Enterprise Server cannot run.

1. Right-click My Computer. Click Manage.

2. In the left pane, expand Local Users and Groups.

3. Navigate to the Groups folder.

4. In the right pane, double-click Administrators.

5. Click Add.

6. In the Enter the object names to select field, type the Windows account name that you want the services for the BlackBerry
Enterprise Server to use (for example, BESAdmin).

7. Click OK.

8. Click Apply.

9. Click OK.

10. On the taskbar, click Start > Programs > Administrative Tools > Local Security Policy.

11. Configure the following permissions for the Windows account:
• log on locally with local permissions (if not assigned by default)
• log on as a service

12. On the taskbar, click Start > Programs > Administrative Tools > Computer Management.

13. Add the Windows account to the local administrators group.

Prevent the Microsoft Exchange known issues for wireless calendar
synchronization
Some known issues for Microsoft® Exchange impact how the BlackBerry® Enterprise Server synchronizes calendars over the
wireless network. To prevent the known issues from occurring, you can read about the known issues for Microsoft Exchange that
might impact your organization's messaging environment and install the hotfixes for them. If your organization's messaging
environment includes multiple messaging servers, you can resolve the known issues that apply to the latest Microsoft Exchange
software version in your organization's environment.

If you do not install the correct hotfixes, the BlackBerry Enterprise Server cannot run.

1. Visit http://support.microsoft.com to read articles 823343 and 894470.

2. Verify that your organization's environment meets the requirements that are described in the applicable known issues.
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3. Download the hotfixes for the known issues on the computers that you want to install the BlackBerry Enterprise Server or
BlackBerry Administration Service on.

4. Install the hotfixes.

Verify if the Windows account can access a user account in Microsoft
Exchange
The BlackBerry® Enterprise Server requires permission to access each BlackBerry device user's mailbox to process email messages.
The IEMSText.exe tool runs a test to verify whether the Windows® account has the Send As permission in Microsoft® Exchange
so that the BlackBerry Enterprise Server can access user accounts. The IEMSText.exe tool does not verify whether the BlackBerry
Enterprise Server can send email messages on behalf of a BlackBerry device user.

1. Copy the BlackBerry® Enterprise Server installation files to the computer that you want to install the BlackBerry Enterprise
Server on.

2. Extract the contents to a folder on the computer.

3. Navigate to <extracted_folder>\Tools.

4. Double-click IEMSTest.exe.

5. In the Profile Name drop-down list, select the profile names for the user accounts.

6. Click OK.

7. In the left pane, select the user accounts that you want to check.

8. Click Select.

9. Click OK.

Configuring connections for the BlackBerry Enterprise Server databases
The BlackBerry® Enterprise Server, BlackBerry Monitoring Service, and BlackBerry MDS Integration Service store data in their
own databases. The database for the BlackBerry Enterprise Server is the BlackBerry Configuration Database.

You create the BlackBerry Configuration Database when you install a BlackBerry Enterprise Server or BlackBerry Administration
Service or when you run the CreateDB executable. You can create the BlackBerry MDS Integration Service database or BlackBerry
Monitoring Service database during the installation processes for the BlackBerry MDS Integration Service or BlackBerry
Monitoring Service, respectively.

The BlackBerry Enterprise Server, BlackBerry Monitoring Service, and BlackBerry MDS Integration Service can connect to their
databases on the Microsoft® SQL Server® using Windows® authentication or database authentication. By default, the BlackBerry
Enterprise Server, BlackBerry Monitoring Service, and BlackBerry MDS Integration Service log in to their databases using the
Windows account that you use to complete the installation process or the database credentials you provided during the installation
process.
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To support database mirroring for the the BlackBerry Configuration Database or BlackBerry MDS Integration Service database
with Microsoft SQL Server 2005 or Microsoft SQL Server 2008, you must use Windows authentication. The BlackBerry Monitoring
Service does not support database mirroring.

Specifying permissions when you connect to the BlackBerry Enterprise Server databases
using Windows authentication or Microsoft SQL Server authentication

If you connect the BlackBerry® Enterprise Server, BlackBerry MDS Integration Service, and BlackBerry Monitoring Service to the
BlackBerry Enterprise Server databases using Windows® authentication or Microsoft® SQL Server® authentication during the
BlackBerry Enterprise Server installation process, the Windows account or Microsoft SQL Server account that you specify must
have database permissions on the database server. The type of permissions that you specify is determined by the setup option
that you select and whether you create the BlackBerry Enterprise Server databases on the computer that hosts the BlackBerry
Enterprise Server components or on another database server.

Specifying permissions for the Windows account or Microsoft SQL Server account

If you install Microsoft® SQL Server® 2005 Express during the BlackBerry® Enterprise Server installation process, you might
need to specify permissions for the Windows® account or Microsoft SQL Server account, depending on the type of authentication
you select.

When you select Windows authentication during the BlackBerry Enterprise Server installation process, the setup application
automatically assigns the required permissions to the Windows account that you use to complete the installation process.

When you select Microsoft SQL Server authentication during the BlackBerry Enterprise Server installation process, you must
assign the required database permissions to the Microsoft SQL Server account that you use to complete the installation process.

Assign permissions to the Windows account or Microsoft SQL Server account

Perform one of the following actions:
• If you create the BlackBerry® Enterprise Server databases on the computer that hosts the BlackBerry Enterprise Server

and you require the setup application to install Microsoft® SQL Server® Express during the installation process and you
choose Windows® authentication, you are not required to assign Microsoft SQL Server permissions to the Windows
account. If you want the setup application to install the BlackBerry database notification system, you must assign the
Microsoft SQL Server permission for the database system administrator (also called the sysadmin server role in Microsoft
SQL Server Management Studio) to the Windows account.

• If you create the BlackBerry Enterprise Server databases on the computer that hosts the BlackBerry Enterprise Server
and you require the setup application to install Microsoft SQL Server Express during the installation process and you
choose Microsoft SQL Server authentication, you must assign the database creator (dbcreator server role) Microsoft SQL
Server permission to the Microsoft SQL Server account. If you want the setup application to install the BlackBerry database
notification system, you must assign the Microsoft SQL Server permission for the database system administrator (also
called the sysadmin server role in Microsoft SQL Server Management Studio) to the Microsoft SQL Server account.
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• If you create the BlackBerry Enterprise Server databases on the computer that hosts the BlackBerry Enterprise Server
and the computer already hosts a Microsoft SQL Server, you must assign the database creator (dbcreator server role)
Microsoft SQL Server permission to the Windows account or Microsoft SQL Server account that you use to complete the
BlackBerry Enterprise Server installation process. If you want the setup application to install the BlackBerry database
notification system, you must assign the Microsoft SQL Server permission for the database system administrator (also
called the sysadmin server role in Microsoft SQL Server Management Studio) to the Windows account or Microsoft SQL
Server account.

• If you create the BlackBerry Enterprise Server databases on a computer that does not host the BlackBerry Enterprise
Server, you must assign the database creator (dbcreator server role) Microsoft SQL Server permission to the Windows
or Microsoft SQL Server account that you use to complete the BlackBerry Enterprise Server installation process. If you
want the setup application to install the BlackBerry database notification system, you must assign the Microsoft SQL
Server permission for the database system administrator (also called the sysadmin server role in Microsoft SQL Server
Management Studio) to the Windows account or Microsoft SQL Server account.

Configuring authentication to the BlackBerry MDS Integration Service database

When the setup application creates the BlackBerry® MDS Integration Service database during the installation process, you must
use the same authentication method and account that you specified for the BlackBerry Configuration Database. The BlackBerry
MDS Integration Service requires the same permissions to access the BlackBerry MDS Integration Service database that the
BlackBerry® Enterprise Server requires to access the BlackBerry Configuration Database.

Resolving IT policy and application control policy conflicts in a mixed version
environment
In BlackBerry® Enterprise Server versions earlier than version 5.0, the BlackBerry Policy Service queues delivery requests for IT
policies and application control policies and sends them to BlackBerry devices. In BlackBerry Enterprise Server version 5.0, the
BlackBerry Administration Service queues the IT policies and application control policies, and the BlackBerry Policy Service sends
them to BlackBerry devices.

To avoid conflicts between the BlackBerry Policy Service and BlackBerry Administration Service in a mixed version environment,
the setup application tries to turn off application polling by the BlackBerry Policy Service for each BlackBerry Enterprise Server
instance in the BlackBerry Domain before it starts the upgrade process. When the setup application turns off application polling,
it prevents earlier versions of the BlackBerry Policy Service from queuing delivery requests for IT policies and application control
policies.

If the setup application cannot turn off application polling for all BlackBerry Enterprise Server instances (for example, a computer
that hosts one of the BlackBerry Enterprise Server instances is not running), you must run the BB50UpgradePrep tool manually
before you can upgrade the BlackBerry Enterprise Server.
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Resolve IT policy and application control policy conflicts in a mixed version environment
1. Copy the BlackBerry® Enterprise Server installation media to the computer that hosts a BlackBerry Enterprise Server.

2. Extract the contents to a folder on the computer.

3. In the  <extracted_folder>\tools folder, double-click BB50UpgradePrep.exe.

4. Complete the instructions on the screen.

Backing up the BlackBerry Configuration Database
You must back up the BlackBerry® Configuration Database so that you can restore it if the BlackBerry® Enterprise Server upgrade
process does not complete.

If your organization's environment includes Microsoft® SQL Server®, use the backup and restore tools that Microsoft provides
to back up the BlackBerry Configuration Database.

If your organization's environment includes an MSDE 2000 or Microsoft SQL Server Express, you can use the BlackBerry
Configuration Database Backup Tool that is included with the BlackBerry Enterprise Server installation media to back up the
BlackBerry Configuration Database to a file. By default, the backup file is named <database_name> <YYYYMMDDHHMMSS>.bak.

Back up the BlackBerry Configuration Database
1. Copy the BlackBerry® Enterprise Server installation media to the database server that hosts the BlackBerry Configuration

Database.

2. Extract the contents of the installation media to a folder on the computer.

3. At the command prompt, navigate to the Tools folder in the BlackBerry Enterprise Server installation media.

4. Run BlackBerryDbBackup.exe.

Example

To back up a BlackBerry Configuration Database that is named BESMgmt to a folder that is named DB_backup_folder, when you
use the database credentials sqlusername and sqlpassword, type

BlackBerryDBBackup.exe -d BESMgmt -f C:\DB_backup_folder -U sqlusername -P sqlpassword.

BlackBerry Configuration Database Backup Tool parameters

The parameters listed in brackets are optional.
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Parameter Description

-d <database _name> This parameter specifies the name of the BlackBerry® Configuration Database (for

example, BESMgmt).

[-f] <folder> This parameter specifies the folder that you want to save the backup file in.

If you specify a folder, it must already exist.

The default folder is the current folder location.

[-S] <database_server> This parameter specifies the name of the database server that hosts the BlackBerry

Configuration Database.

[-E] This parameter specifies that you want to use Windows® authentication instead of

database authentication to connect to the database server.

Your login account must have the database owner permission.

The default value is false (Windows authentication).

[-U] <user_name> This parameter specifies the user name that you use for database authentication.

To use a login account that is different from the default login account, the account

must have database owner permission.

The default user name is sa.

[-P] <password> This parameter specifies the password that you use for for database authentication.

[-p] <percentage> This parameter specifies the interval, as a percentage, that you want the BlackBerry

Configuration Database Backup Tool to report progress at.

The default percentage is 10.

[-?] This parameter specifies information about the BlackBerry Configuration Database

Backup Tool. You do not require any other parameters when you use this parameter.

Migrating BlackBerry MDS Runtime Applications
Previous versions of the BlackBerry® MDS Integration Service used a BlackBerry MDS Integration Service database (mdss), and
a BlackBerry MDS Integration Service discovery database (mdss_dis) to store BlackBerry® MDS Runtime Applications and
application data. The latest BlackBerry MDS Integration Service version does not use a BlackBerry MDS Integration Service
discovery database. During the upgrade process, the setup application merges all tables of the BlackBerry MDS Integration
Service discovery database into the BlackBerry MDS Integration Service database. As a result, the upgrade process does not
migrate all published BlackBerry MDS Integration Service applications such as BlackBerry MDS Runtime Applications.
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To migrate BlackBerry MDS Runtime Applications, you must republish the BlackBerry MDS Runtime Applications to the BlackBerry
MDS Application Repository after the upgrade process completes, or you must migrate the BlackBerry MDS Integration Service
discovery database to the BlackBerry MDS Integration Service version 4.1 database before you start the upgrade process. If you
migrate the BlackBerry MDS Integration Service discovery database and install new BlackBerry MDS Integration Service instances
instead of upgrading the existing BlackBerry MDS Integration Service instances, you must reconfigure any backend notification
subscriptions. If you migrate the BlackBerry MDS Integration Service discovery database, BlackBerry devices that are running
BlackBerry® MDS Runtime versions earlier than version 4.5 remove the applications that are installed.

Migrate data from the BlackBerry MDS Integration Service discovery database to the
BlackBerry MDS Integration Service database
1. Open the Microsoft® SQL Server® console.

2. Generate scripts for the following tables in the BlackBerry® MDS Integration Service discovery database:
• REGISTRY_APP
• REGISTRY_APP_LOCALE
• REGISTRY_APP_KEYWORD
• REGISTRY_APP_DEPEND

3. To create the tables in the BlackBerry MDS Integration Service database, execute the generated scripts against the
BlackBerry MDS Integration Service database.

4. Export data from the tables that are listed in step 2.

5. Import the data into the BlackBerry MDS Integration Service database.

After you finish: To migrate user accounts to the BlackBerry MDS Integration Service pool after you complete the upgrade
process, use the BlackBerry Administration Service to update the BlackBerry® Enterprise Server to use the new BlackBerry MDS
Integration Service pool.

Install the SNMP service for monitoring by the BlackBerry Monitoring Service
If you want to install the BlackBerry® Monitoring Service on a computer in the BlackBerry Domain, you must install the SNMP
service on each computer that you want to install the BlackBerry® Enterprise Server on so that the BlackBerry Monitoring Service
can monitor the BlackBerry Enterprise Server activity.

Before you begin: Verify that each computer can access the Windows® installation media.

1. On the taskbar, click Start > Settings > Control Panel > Add/Remove Programs > Add/Remove Windows Components.

2. Double-click Management and Monitoring Tools.

3. Select the Simple Network Management Protocol check box.

4. Click OK.

5. When Windows Setup prompts you, install the files from the Windows installation media.
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6. Complete the installation wizard.

7. In the Windows Services, verify that the SNMP service is running.

After you finish: To complete the SNMP service installation process, after you install the BlackBerry Enterprise Server or
BlackBerry Enterprise Server components, configure the SNMP service to monitor the activity of the BlackBerry Enterprise Server
or BlackBerry Enterprise Server components.

Creating a BlackBerry Administration Service pool using DNS round robin
that includes the BlackBerry Web Desktop Manager
When you install the BlackBerry® Administration Service, BlackBerry® Web Desktop Manager, or both, the setup application
installs the BlackBerry Administration Service services automatically. The BlackBerry Administration Service and BlackBerry Web
Desktop Manager require the BlackBerry Administration Service services to run.

If you create a BlackBerry Administration Service pool using DNS round robin, you can install the BlackBerry Administration
Service and BlackBerry Web Desktop Manager on each computer in the pool or you can install the BlackBerry Administration
Service or BlackBerry Web Desktop Manager on some of the computers in the pool. If you install the BlackBerry Administration
Service and BlackBerry Web Desktop Manager on each computer in the pool, you can use the pool name that you specified during
the installation process in the URLs for the BlackBerry Administration Service and BlackBerry Web Desktop Manager (for example,
https://<pool_name>/webconsole/login or https://<pool_name>/webdesktop/login).

If you do not install both components on each computer in the pool and you try to access one of the URLs using the pool name,
the web browser might display an HTTP 404 error message. The HTTP 404 error message occurs when the web browser tries to
connect to a computer in the pool that you did not install the component on that you are trying to access. For example, you can
install the BlackBerry Administration Service on two of the computers in the pool and the BlackBerry Web Desktop Manager on
two other computers in the pool.

To make sure that the web browser does not display HTTP 404 error messages, you can choose one of the following options:
• You can create separate pools within the BlackBerry Administration Service pool for the BlackBerry Administration Service

and the BlackBerry Web Desktop Manager. You can provide your organization's administrators and BlackBerry device users
with URLs that include the specific pool names.

• You can provide administrators and users in your organization's environment with URLs that include the FQDNs of the
computers that you installed the BlackBerry Administration Service or BlackBerry Web Desktop Manager on (for example,
https://<FQDN_of_computer>/webconsole/login or https://<FQDN_of_computer>/webdesktop/login).

Creating a BlackBerry MDS Integration Service pool
You can create a BlackBerry® MDS Integration Service pool using the setup application during the installation processes for the
BlackBerry MDS Integration Service instances that you want to include in the pool. During the installation process for the first
BlackBerry MDS Integration Service instance, you must type a unique FQDN or DNS name that identifies the pool. During the
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installation processes for the subsequent BlackBerry MDS Integration Service instances, you must select the existing pool name
from the list so that you can add the instances to the pool. After you complete the installation processes, BlackBerry MDS
Integration Service clients can access the BlackBerry MDS Integration Service instances in the pool using the unique DNS name.

Create the DNS record for a BlackBerry Administration Service instance or
BlackBerry MDS Integration Service instance
To configure multiple BlackBerry® Administration Service instances or BlackBerry MDS Integration Service instances for high
availability using DNS round robin, you must create a DNS record. The DNS record permits the clients of the BlackBerry
Administration Service pool or BlackBerry MDS Integration Service pool to access the instances using a single DNS name. You
must create the DNS record in the same domain as the computers that host the BlackBerry Administration Service instances or
BlackBerry MDS Integration Service instances.

Before you begin:
• You must configure a static IP address for each computer that you want to install a BlackBerry MDS Integration Service

instance or BlackBerry Administration Service instance on.
• You must have permission to manage the DNS.
• If you configure DNS round robin, you must configure clients to resolve the DNS name into a list of IP addresses and

distribute traffic equally across the BlackBerry Administration Service or BlackBerry MDS Integration Service instances in
the pool.

1. Log in to the DNS server.

2. In the DNS management console, access the forward lookup zone that you want to add the BlackBerry Administration
Service instance or BlackBerry MDS Integration Service instance to.

3. To create a new host, type the following information:

• In the Name field, type the name of the BlackBerry Administration Service pool or BlackBerry MDS Integration Service
pool that you want to use.

• In the IP Address1 field, type the IP address of the computer that you want to host a BlackBerry Administration Service
instance or BlackBerry MDS Integration Service instance on.

• Select the Create associated pointer (PTR) record check box.

4. Repeat step 3 for each BlackBerry Administration Service instance or BlackBerry MDS Integration Service instance that you
want to install. When you add entries to the same pool, you must use the same pool name for all BlackBerry Administration
Service instances or BlackBerry MDS Integration Service instances.

After you finish: To remove a BlackBerry Administration Service instance or BlackBerry MDS Integration Service instance from
a pool, delete the entry for the IP address of the BlackBerry Administration Service instance or BlackBerry MDS Integration Service
instance from the DNS server.
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Applications that are installed with the BlackBerry Enterprise Server
components
The BlackBerry® Enterprise Server installation process can include the installation of third-party applications.

Application BlackBerry Enterprise Server components that the application is

installed with

JDK with JRE™ version 1.6.15 • BlackBerry Administration Service

• BlackBerry Monitoring Service

JDK version 1.6.15 • BlackBerry Administration Service

• BlackBerry Collaboration Service

• BlackBerry MDS Connection Service

• BlackBerry MDS Integration Service

Microsoft® XML Parser version 6.0 SP2 all components except the BlackBerry Router

Microsoft® SQL Server® 2005 Express Edition

SP3 (if selected)
• BlackBerry Administration Service

• any other components

Microsoft® .NET Framework version 2.0

(if you are installing Microsoft SQL Server

Express)

• All components

Prerequisites: Upgrading the BlackBerry Enterprise Server software
• Verify that the Windows® account that you use to install the BlackBerry® Enterprise Server software is assigned the local

administrator permission on the computer that you perform the installation process on.
• Verify that the Windows account that you want to use to install the BlackBerry Enterprise Server software is not a member

of the Domain Admins group in Microsoft® Active Directory®.
• Delete inactive user accounts from the BlackBerry Enterprise Server.
• Remove the BlackBerry Administration API from all of the computers that host the BlackBerry Administration Service in the

BlackBerry Domain. You can use the Windows control panel to remove the BlackBerry Administration API. In BlackBerry
Enterprise Server version 5.0 SP1, the setup application installs the BlackBerry Administration API automatically when the
setup application installs the BlackBerry Administration Service.

• Close all BlackBerry Manager instances in the BlackBerry Domain and do not reopen them. If you run the BlackBerry Manager
with BlackBerry Enterprise Server version 5.0 and later, you might experience issues with the BlackBerry Configuration
Database.
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• Retrieve the following information:
• BlackBerry® Client Access License key
• SRP host (in BlackBerry Enterprise Server version 5.0 and later, the format of the SRP host is different from earlier

versions)
• SRP identifier
• SRP key
• computer name and port number of the instant messaging server (use the virtual server name and port number where

the AJAX Service is installed, if applicable)
• computer name and port number of the proxy server (optional)

• If you upgrade from the BlackBerry Enterprise Server Small Business Edition or BlackBerry® Professional Software to a
BlackBerry Enterprise Server, retrieve a new BlackBerry CAL key. For more information, visit www.blackberry.com/support
to read article KB03535.

• Upgrade all BlackBerry Enterprise Server instances to version 4.0 SP7 (if your organization includes only one BlackBerry
Enterprise Server instance in the BlackBerry Domain), 4.1 SP3, or later.

• Install or upgrade the BlackBerry Administration Service on the computer that you perform the upgrade process on in the
BlackBerry Domain first.

• Back up the BlackBerry Enterprise Server databases.
• If you configured the BlackBerry Administration Service instances in the pool to communicate across network subnets with

TCP, back up the TCP communication files for the BlackBerry Administration Service. For more information, visit
www.blackberry.com/support to read article KB19654.

• If you configured database replication for the BlackBerry Configuration Database, turn database replication off.
• If you installed the BlackBerry database notification system on a remote Microsoft® SQL Server®, upgrade the BlackBerry

database notification system manually.
• If you upgrade from a beta version of BlackBerry Enterprise Server 5.0 or 5.0 SP1 and you installed the BlackBerry

Administration Service on a computer that is separate from the computer that hosts the BlackBerry Enterprise Server, in
the Windows® Services, stop the BlackBerry Administration Service Application Servers and the BlackBerry Administration
Service Native Code Containers services.

• If you want to install Microsoft® SQL Server® 2005 Express Edition SP3 on a computer that does not host any BlackBerry
Enterprise Server components, you can navigate to the Tools folder in the BlackBerry Enterprise Server installation files and
run Sqlexpr.exe.

• If you install the BlackBerry Administration Service, verify that the computers that host the BlackBerry Administration Service
and the BlackBerry Configuration Database are not separated by a WAN bridge.

• If you perform the upgrade on a computer that has more than one NIC, verify that the production NIC is first in the bind
order in Windows network settings.

Performing a test upgrade of the BlackBerry Configuration Database
If you want to make sure that you can upgrade the BlackBerry® Configuration Database in your organization's environment
without any issues or if you want to find out how long it takes to upgrade the BlackBerry Configuration Database, you can perform
a test upgrade of the BlackBerry Configuration Database.

Upgrade Guide Performing a test upgrade of the BlackBerry Configuration Database
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When you perform a test upgrade of the BlackBerry Configuration Database, you back up the BlackBerry Configuration Database,
restore the backup version of the BlackBerry Configuration Database to a database server that does not host the BlackBerry
Configuration Database, and then run the CreateDB executable.

Perform a test upgrade of the BlackBerry Configuration Database

Before you begin: Verify that you configured the appropriate permissions on the database server that you want to perform a
test upgrade of the BlackBerry® Configuration Database on.

1. Log in to the computer that hosts the BlackBerry Configuration Database using a local administrator account or a Windows
account that has SQL administrator permissions.

2. Back up the BlackBerry Configuration Database.

3. Log in to a computer that hosts a database server that you want to perform a test upgrade of the BlackBerry Configuration
Database on using a local administrator account or a Windows account that has SQL administrator permissions.

4. Restore the backup version of the BlackBerry Configuration Database.

5. Copy the BlackBerry® Enterprise Server installation files to the database server.

6. Extract the contents to a folder on the computer.

7. Navigate to  <extracted_folder>\Database.

8. Open the BesMgmt.cfg file in a text editor.

9. Change the file to include information that is specific to your organization's environment.

10. Save and close the file.

11. Open a command prompt window.

12. Change to  <extracted_folder>\Database.

13. Type CreateDB.exe BESMgmt.cfg.

BESMgmt.cfg properties

Property Description

DATABASE_NAME This property specifies the name of the BlackBerry® Configuration Database.

CMD This property specifies the type of action that the CreateDB executable must

complete (for example, whether to install or upgrade the BlackBerry Configuration

Database).

USERID If you use database authentication, this property specifies the user name of the

database account that has server administrator permission and database creator

permission.
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Property Description

PASSWORD If you use database authentication, this property specifies the password for the

database account.

SCRIPT_ROOT This property specifies the path to the DBInstallScripts folder.

By default, this folder is in the same root folder that the CreateDB.exe file is located

in.

LOG_DIR This property specifies the path to the folder that you want to create log files in.

By default, this folder is in the same root folder that the CreateDB.exe file is located

in.

DBMS This property specifies the database management system that your organization

uses.

DB_FILE_DIR This property specifies an existing folder that you want to save the database files in.

By default, this folder is in the same root folder that the CreateDB.exe file is located

in.

BACKUP_DIR This property specifies an existing folder where you want to save the database

backup in.

By default, this folder is located in the same root folder that the CreateDB.exe file

is located in.
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Upgrading the BlackBerry Enterprise Server software by
using the in-place upgrade process

6

Using the in-place upgrade process, you can upgrade the BlackBerry® Enterprise Server software by replacing the existing version
and upgrading the BlackBerry Configuration Database.

You can use the in-place upgrade process if your organization's environment includes a standalone BlackBerry Enterprise Server
instance.

When you use the in-place upgrade process, all BlackBerry devices receive new IT policies. BlackBerry devices that are running
BlackBerry® Device Software version 4.1 or later receive new service books and data synchronization occurs over the wireless
network.

Avantages of this upgrade process include:
• You do not require an extra computer to perform this upgrade.
• When the upgrade process completes, user accounts are active and no additional administrative action is required.

Disadvantages of this upgrade process include:
• After you upgrade the BlackBerry Enterprise Server, you cannot return to an earlier version of the software automatically.
• You must turn off the BlackBerry Enterprise Server during the upgrade process. The interruption to services for BlackBerry

devices lasts for as long as it takes the upgrade process to complete.

Upgrade the BlackBerry Enterprise Server software by overwriting the
existing version and use the existing BlackBerry Configuration Database
The in-place upgrade process requires that you restart the computer.

During the BlackBerry® Enterprise Server installation process, you must restart the computer.

Before you begin:
• Instruct your organization's administrators to stop managing the BlackBerry Enterprise Server using the BlackBerry Manager

or administration clients that use the BlackBerry® Enterprise Server Resource Kit.
• If a remote Microsoft® SQL Server® hosts the BlackBerry Configuration Database, upgrade the BlackBerry database

notification system.

1. Log in to the computer using the Windows® account that the BlackBerry Enterprise Server services run on.

2. In the BlackBerry Enterprise Server installation files, double-click setup.exe.

3. In the Setup type dialog box, select Use an existing BlackBerry Configuration Database.

4. In the Database information dialog box, perform the following actions:
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• Verify the names of the database server and BlackBerry Configuration Database that the BlackBerry Enterprise Server
uses.

• If you configured the database server to use static ports, select the Static option. If the static port number is not 1433,
in the Port field, type the port number.

5. In the Database mirroring options dialog box, if you want to configure database mirroring, select the Add support for
database mirroring check box and type the name of the database server that hosts the mirror database in the Name of
the mirror database server field. The setup application does not create the BlackBerry Configuration Database on the
mirror Microsoft SQL Server; it adds a registry key to the computer that includes the name of the mirror Microsoft SQL Server.

6. In the Microsoft Exchange Server dialog box, perform the following actions:

a. In the Microsoft Exchange server field, type the name of the Microsoft® Exchange server.

b. In the Mailbox field, type the name of the administrator that has the appropriate permissions.

c. Click Check Name.

d. Click Apply.

e. Click OK.

7. In the Setup options dialog box, for the first upgrade in the BlackBerry Domain, to install the BlackBerry Administration
Service, under Additional Components, select BlackBerry Administration Service. If you do not want to install the
BlackBerry Administration Service, you must perform the first upgrade in the BlackBerry Domain from a computer that the
BlackBerry Administration Service is already installed on.

8. When prompted to restart the computer, click Yes.

9. Log in to the computer using the same account that you used in step 1.

10. In the Application extensibility settings dialog box, consider the following information:
• You can type an FQDN to create a new BlackBerry MDS Integration Service pool.
• To configure a hardware load-balancer for the BlackBerry MDS Integration Service pool, you can type an FQDN that

corresponds to a DNS record in the DNS server that maps the FQDN to the IP address of the virtual server that you
configured on the hardware load-balancer.

• If you choose to create a new BlackBerry MDS Integration Service database, the setup application creates the BlackBerry
MDS Integration Service database on the same database server as the BlackBerry Configuration Database.

11. If you upgrade from the BlackBerry Collaboration Service for use with Windows® Messenger, in the Instant messaging
settings dialog box, type the Microsoft® Office Live Communications Server 2005 address.

12. In the Administration settings dialog box, perform the following actions:
• In the Pool name field, type an FQDN that the setup application can use to create the BlackBerry Administration Service

web address. If you install only one BlackBerry Administration Service instance in the BlackBerry Domain, you can accept
the default pool name. If you install more than one BlackBerry Administration Service instance in the BlackBerry Domain,
you must create a DNS entry for the pool name that is not the name of a computer and is mapped to the IP address of
each BlackBerry Administration Service instance.
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• In the New password and Confirm password fields, type the password for the SSL certificate that the BlackBerry
Administration Service uses to authenticate with browsers. You must use the same password for every BlackBerry
Administration Service instance in the BlackBerry Domain.

13. In the Microsoft® Active Directory® settings dialog box, in the User password field, type the password for the Microsoft
Active Directory account (for example, BESAdmin) that the BlackBerry Enterprise Server uses to authenticate to Microsoft
Active Directory. If you want to specify a different user name and user domain, you must make sure that the user domain
belongs to the same Microsoft Active Directory forest as the Microsoft Exchange organization.

If the setup application cannot locate any of the global catalog servers that are associated with the Microsoft Active Directory
account after you click the Next button, you must choose the global catalog servers that you want to add to the list manually.
To add a global catalog server to the list, click the Add button and select the appropriate server. Each global catalog server
that you add to the list must belong to the same domain as the Microsoft Active Directory user account.

14. Start the services for the BlackBerry Enterprise Server. If you installed the BlackBerry Administration Service, the setup
application waits until the BlackBerry Administration Service services are running before the setup application continues.

15. In the Console addresses dialog box, copy the web addresses for the BlackBerry Enterprise Server components and paste
them into a document for future reference. You can use the web addresses to log in to the BlackBerry Enterprise Server
components that you installed.

After you finish:
• If you configured the BlackBerry Administration Service instances in the pool to communicate across network subnets with

TCP before you upgraded BlackBerry Enterprise Server components, you must restore the configuration files. For more
information, visit www.blackberry.com/support to read article KB19654.

• As required, add the name of the BlackBerry MDS Integration Service pool to the DNS server and change the name of the
computer.

Specifying a name for the BlackBerry Administration Service pool during the installation
process

During the installation process, the setup application prompts you to specify the name of the BlackBerry® Administration Service
pool.

The BlackBerry Administration Service instances use the pool name for interprocess communication and when you configure
BlackBerry Administration Service high availability using DNS round robin. You must specify a valid DNS host name during the
installation process, even if you do not configure BlackBerry Administration Service high availability using DNS round robin.

The setup application uses the FQDN of the computer that you install the first BlackBerry Administration Service instance on as
the default value for the pool name. If you keep the default value and configure BlackBerry Administration Service high availability
using DNS round robin at a later time, you must use the BlackBerry Configuration Panel to change the pool name to the host
name for the pool.

The name for the BlackBerry Administration Service pool does not impact BlackBerry Administration Service high availability
that uses a hardware load balancer.
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For more information about BlackBerry Administration Service high availability, see the BlackBerry Enterprise Server Planning
Guide.

Upgrade the BlackBerry Enterprise Server instances that you configured for
disaster recovery
If you configured the BlackBerry® Enterprise Server instances in your organization's environment for disaster recovery, you
configured two BlackBerry Enterprise Server instances that use the same SRP address. You can upgrade the BlackBerry Enterprise
Server instances to the latest BlackBerry Enterprise Server version and configure high availability so that the BlackBerry Enterprise
Server instances can fail over automatically.

1. Upgrade the standby BlackBerry Enterprise Server using the in-place upgrade process. During the upgrade process, do not
verify the SRP credentials or start the BlackBerry Enterprise Server services so that you do not deactivate the SRP credentials.

2. Stop BlackBerry Enterprise Server version 4.1 so that you can start a manual failover process.

3. Start the latest BlackBerry Enterprise Server version so that it becomes the primary instance.

4. Verify that users can send and receive messages on their BlackBerry devices.

5. Upgrade the earlier BlackBerry Enterprise Server version using the in-place upgrade process. During the upgrade process,
specify that this BlackBerry Enterprise Server instance is a standby BlackBerry Enterprise Server, and associate it with the
BlackBerry Enterprise Server instance that you upgraded in step 1.

6. Using the BlackBerry Administration Service, fail over to the BlackBerry Enterprise Server manually that you want to use as
the primary instance.

7. Configure the automatic failover feature.

After you finish: For more information, see the BlackBerry Enterprise Server Installation Guide and the BlackBerry Enterprise
Server Administration Guide.
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Upgrading the BlackBerry Enterprise Server using the
cutover upgrade process and upgrade the existing
BlackBerry Configuration Database

7

Using the cutover upgrade process, you can install a BlackBerry® Enterprise Server on a new computer and move user accounts
and server information from a previous BlackBerry Enterprise Server to the new one.

When you use the cutover upgrade process, all BlackBerry devices receive new IT policies. BlackBerry devices that are running
BlackBerry® Device Software version 4.1 or later receive new service books and data synchronization occurs over the wireless
network.

If you upgrade the existing BlackBerry Configuration Database, you can move user accounts from the previous BlackBerry
Enterprise Server to the new one using the BlackBerry Administration Service.

Advantages of this upgrade process include:
• You can move user accounts back to the previous BlackBerry Enterprise Server if you experience issues with the new one.
• You can upgrade server hardware.
• Users experience minimal service interruptions because user accounts remain active on the previous BlackBerry Enterprise

Server until you start the new one.

Disadvantages of this upgrade process include:
• You require an extra computer.
• The BlackBerry Enterprise Server sends new service books to all of the BlackBerry devices that are capable of synchronizing

data over the wireless network.

Upgrade a BlackBerry Configuration Database
If you are not a database administrator and you do not have permissions to modify the BlackBerry® Configuration Database, you
can request that a database administrator with the appropriate permissions upgrades the BlackBerry Configuration Database
before you run the setup application and upgrade the BlackBerry® Enterprise Server.

Before you begin: Verify that you configured the proper permissions on the database server.

1. Log in to the computer that hosts the database server as a local administrator or using a Windows® account that has SQL
administrator permissions.

2. Copy the BlackBerry Enterprise Server installation media to the database server that hosts the BlackBerry Configuration
Database.

3. Extract the contents to a folder on the computer.

4. Navigate to  <extracted_folder>\Database.
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5. Open the BesMgmt.cfg file in a text editor.

6. Change the file to include information that is specific to your organization's environment.

7. Save and close the file.

8. Open a command prompt window.

9. Navigate to  <extracted_folder>\Database.

10. Type CreateDB.exe BESMgmt.cfg.

BESMgmt.cfg properties

Property Description

DATABASE_NAME This property specifies the name of the BlackBerry® Configuration Database.

CMD This property specifies the type of action that the CreateDB executable must

complete (for example, whether to install or upgrade the BlackBerry Configuration

Database).

USERID If you use database authentication, this property specifies the user name of the

database account that has server administrator permission and database creator

permission.

PASSWORD If you use database authentication, this property specifies the password for the

database account.

SCRIPT_ROOT This property specifies the path to the DBInstallScripts folder.

By default, this folder is in the same root folder that the CreateDB.exe file is located

in.

LOG_DIR This property specifies the path to the folder that you want to create log files in.

By default, this folder is in the same root folder that the CreateDB.exe file is located

in.

DBMS This property specifies the database management system that your organization

uses.

DB_FILE_DIR This property specifies an existing folder that you want to save the database files in.

By default, this folder is in the same root folder that the CreateDB.exe file is located

in.

BACKUP_DIR This property specifies an existing folder where you want to save the database

backup in.

Upgrade Guide Upgrade a BlackBerry Configuration Database

43



Property Description

By default, this folder is located in the same root folder that the CreateDB.exe file

is located in.

Install the BlackBerry Enterprise Server on a new computer and upgrade the
existing BlackBerry Configuration Database
To administer the BlackBerry® Enterprise Server, you must install the BlackBerry Administration Service. You can install the
BlackBerry Administration Service on the computer that hosts the BlackBerry Enterprise Server or on a separate computer. You
must either install or upgrade the BlackBerry Administration Service on the computer that you perform the installation process
on in the BlackBerry Domain first.

During the BlackBerry Enterprise Server installation process, you must restart the computer.

1. Log in to the computer using the Windows® account that you want the BlackBerry Enterprise Server services to run on.

2. In the BlackBerry Enterprise Server installation files, double-click setup.exe.

3. In the Setup type dialog box, select Use an existing BlackBerry Configuration Database.

4. In the Database information dialog box, perform the following actions:
• Verify the names of the database server and BlackBerry Configuration Database that the BlackBerry Enterprise Server

uses.

• If you configured the database server to use static ports, select the Static option. If the static port number is not 1433,
in the Port field, type the port number.

5. In the Database mirroring options dialog box, if you want to configure database mirroring, select the Add support for
database mirroring check box and type the name of the database server that hosts the mirror database in the Name of
the mirror database server field. The setup application does not create the BlackBerry Configuration Database on the
mirror Microsoft® SQL Server®; it adds a registry key to the computer that includes the name of the mirror Microsoft SQL
Server.

6. In the Microsoft Exchange Server dialog box, perform the following actions:

a. In the Microsoft Exchange server field, type the name of the Microsoft® Exchange server.

b. In the Mailbox field, type the name of the administrator that has the appropriate permissions.

c. Click Check Name.

d. Click Apply.

e. Click OK.

7. In the Setup options dialog box, consider the following information:
• For the first upgrade in a BlackBerry Domain, to install the BlackBerry Administration Service, select BlackBerry

Administration Service under Additional Components.
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• To install the BlackBerry Administration Service by itself, select Remote component and BlackBerry Administration
Service.

8. When the setup application prompts you to restart the computer, click Yes.

9. Log in to the computer using the same account that you used in step 1.

10. In the CAL and SRP Information dialog box, type the SRP credentials that the BlackBerry Enterprise Server that you are
replacing uses.

11. In the Application extensibility settings dialog box, consider the following information:
• You can type a FQDN to create a new BlackBerry MDS Integration Service pool.
• To configure a hardware load-balancer for the BlackBerry MDS Integration Service pool, you can type a FQDN that

corresponds to a DNS record in the DNS server that maps the FQDN to the IP address of the virtual server that you
configured on the hardware load-balancer.

• You can create a new BlackBerry MDS Integration Service database or upgrade the existing BlackBerry MDS Integration
Service database.

• If you choose to create a new BlackBerry MDS Integration Service database, the setup application creates the BlackBerry
MDS Integration Service database on the database server that the BlackBerry Configuration Database is located on.

12. If you upgrade from the BlackBerry Collaboration Service for use with Windows® Messenger, in the Instant messaging
settings dialog box, type the Microsoft® Office Live Communications Server 2005 address.

13. In the Administration settings dialog box, perform the following actions:
• In the Pool name field, type an FQDN that the setup application can use to create the BlackBerry Administration Service

web address. If you install only one BlackBerry Administration Service instance in the BlackBerry Domain, you can accept
the default pool name. If you install more than one BlackBerry Administration Service instance in the BlackBerry Domain,
you must create a DNS entry for the pool name that is not the name of a computer and is mapped to the IP address of
each BlackBerry Administration Service instance.

• In the New password and Confirm password fields, type the password for the SSL certificate that the BlackBerry
Administration Service uses to authenticate with browsers. You must use the same password for every BlackBerry
Administration Service instance in the BlackBerry Domain.

14. In the Microsoft® Active Directory® settings dialog box, in the User password field, type the password for the Microsoft
Active Directory account (for example, BESAdmin) that the BlackBerry Enterprise Server uses to authenticate to Microsoft
Active Directory. If you want to specify a different user name and user domain, you must make sure that the user domain
belongs to the same Microsoft Active Directory forest as the Microsoft Exchange organization.

If the setup application cannot locate any of the global catalog servers that are associated with the Microsoft Active Directory
account after you click the Next button, you must choose the global catalog servers that you want to add to the list manually.
To add a global catalog server to the list, click the Add button and select the appropriate server. Each global catalog server
that you add to the list must belong to the same domain as the Microsoft Active Directory user account.

15. If you use the SRP credentials of an existing BlackBerry Enterprise Server in the BlackBerry Domain, do not start the
BlackBerry Enterprise Server services.
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16. In the Console addresses dialog box, copy the web addresses for the BlackBerry Enterprise Server components and paste
them into a document for future reference. You can use the web addresses to log in to the BlackBerry Enterprise Server
components that you installed.

After you finish:
• If you configured the BlackBerry Administration Service instances in the pool to communicate across network subnets with

TCP before you upgraded BlackBerry Enterprise Server components, you must restore the configuration files. For more
information, visit www.blackberry.com/support to read article KB19654.

• As required, add the name of the BlackBerry MDS Integration Service pool to the DNS server and change the name of the
computer.

Specifying a name for the BlackBerry Administration Service pool during the installation
process

During the installation process, the setup application prompts you to specify the name of the BlackBerry® Administration Service
pool.

The BlackBerry Administration Service instances use the pool name for interprocess communication and when you configure
BlackBerry Administration Service high availability using DNS round robin. You must specify a valid DNS host name during the
installation process, even if you do not configure BlackBerry Administration Service high availability using DNS round robin.

The setup application uses the FQDN of the computer that you install the first BlackBerry Administration Service instance on as
the default value for the pool name. If you keep the default value and configure BlackBerry Administration Service high availability
using DNS round robin at a later time, you must use the BlackBerry Configuration Panel to change the pool name to the host
name for the pool.

The name for the BlackBerry Administration Service pool does not impact BlackBerry Administration Service high availability
that uses a hardware load balancer.

For more information about BlackBerry Administration Service high availability, see the BlackBerry Enterprise Server Planning
Guide.

Move user accounts to a new BlackBerry Enterprise Server using the
BlackBerry Administration Service
To complete the cutover upgrade process, you must move user accounts to the new BlackBerry® Enterprise Server. After you
move the user accounts to the current BlackBerry Enterprise Server, the BlackBerry Enterprise Server sends new service books
to the BlackBerry devices automatically.

1. In the BlackBerry Administration Service, on the BlackBerry Solution management menu, expand User.

2. Click Manage Users.
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3. Click Advanced.

4. In the BlackBerry Enterprise Server criteria section, click the BlackBerry Enterprise Server that you want to move user
accounts from.

5. Click Search.

6. Click Manage multiple users.

7. Select the user accounts that you want to move to the new BlackBerry Enterprise Server at the same time

8. Click Switch BlackBerry user to different BlackBerry Enterprise Server.

9. Select the new BlackBerry Enterprise Server from the list.

10. Click Save All.

After you finish: Reassign the IT policies to the user accounts.

Prevent the previous BlackBerry Enterprise Server from connecting to the
BlackBerry Infrastructure
If you try to connect two BlackBerry® Enterprise Server instances to the BlackBerry® Infrastructure using identical SRP credentials,
the BlackBerry Infrastructure deactivates the credentials, and wireless traffic stops.

1. In the Windows® Services, stop all BlackBerry Enterprise Server services.

2. Change the startup type for all BlackBerry Enterprise Server services to Disabled.

Start the new BlackBerry Enterprise Server
In the Windows® Services, start the BlackBerry® Enterprise Server services in the following order:
• BlackBerry Controller
• BlackBerry Router
• BlackBerry Dispatcher
• all remaining services

After you finish: After you complete the upgrade process, users must reactivate their BlackBerry devices. Instruct users to connect
their BlackBerry devices to the BlackBerry® Desktop Manager or BlackBerry® Web Desktop Manager to receive new SRP routing
and service name information.
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Upgrading the BlackBerry Enterprise Server using the
cutover upgrade process and create a BlackBerry
Configuration Database

8

Using the cutover upgrade process, you can install the BlackBerry® Enterprise Server on a new computer and move user accounts
and server information from the previous BlackBerry Enterprise Server to the new one.

You can use the cutover upgrade process to create a new BlackBerry Configuration Database and BlackBerry Domain. If you
create a new BlackBerry Configuration Database, you require SRP credentials for the new BlackBerry Enterprise Server. You can
move user accounts from the previous BlackBerry Configuration Database to the new BlackBerry Configuration Database using
the BlackBerry Enterprise Transporter.

When you use the cutover upgrade process, all BlackBerry devices receive new IT policies. BlackBerry devices that are running
BlackBerry® Device Software version 4.1 or later receive new service books and wireless data synchronization occurs.

Advantages of this upgrade process include:
• You can move user accounts back to the previous BlackBerry Enterprise Server if you experience any issues with the new one.
• You can upgrade server hardware.
• Users experience minimal service interruptions because user accounts remain active on the previous BlackBerry Enterprise

Server until you start the new one.

Disadvantages of this upgrade process include:
• You require an extra computer.
• The BlackBerry Enterprise Server sends new service books to all of the BlackBerry devices that are capable of synchronizing

data over the wireless network.

Create a BlackBerry Configuration Database
If the security required by your organization does not allow applications to have permissions to create or upgrade databases, you
can run the CreateDB executable on the database server to create the BlackBerry® Configuration Database instead of using the
setup application. After you create or upgrade the BlackBerry Configuration Database using the CreateDB executable, you can
run the setup application using a Windows® account with minimum requirements to the database server.

Before you begin: Verify that the appropriate permissions are configured on the database server.

1. Log in to the computer that hosts the database server using a local administrator account or a Windows account that has
SQL administrator permissions.

2. Copy the BlackBerry® Enterprise Server installation media to the database server that you want to configure as the host
server for the BlackBerry Configuration Database.

3. Extract the contents to a folder on the computer.
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4. Navigate to  <extracted_folder>\Database.

5. Open the BesMgmt.cfg file in a text editor.

6. Change the file to include information that is specific to your organization's environment.

7. Save and close the file.

8. Open a command prompt window.

9. Change to  <extracted_folder>\Database.

10. Type CreateDB.exe BESMgmt.cfg.

BESMgmt.cfg properties

Property Description

DATABASE_NAME This property specifies the name of the BlackBerry® Configuration Database.

CMD This property specifies the type of action that the CreateDB executable must

complete (for example, whether to install or upgrade the BlackBerry Configuration

Database).

USERID If you use database authentication, this property specifies the user name of the

database account that has server administrator permission and database creator

permission.

PASSWORD If you use database authentication, this property specifies the password for the

database account.

SCRIPT_ROOT This property specifies the path to the DBInstallScripts folder.

By default, this folder is in the same root folder that the CreateDB.exe file is located

in.

LOG_DIR This property specifies the path to the folder that you want to create log files in.

By default, this folder is in the same root folder that the CreateDB.exe file is located

in.

DBMS This property specifies the database management system that your organization

uses.

DB_FILE_DIR This property specifies an existing folder that you want to save the database files in.

By default, this folder is in the same root folder that the CreateDB.exe file is located

in.
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Property Description

BACKUP_DIR This property specifies an existing folder where you want to save the database

backup in.

By default, this folder is located in the same root folder that the CreateDB.exe file

is located in.

Install the BlackBerry Enterprise Server on a new computer and create a new
BlackBerry Configuration Database
During the BlackBerry® Enterprise Server installation process, you must restart the computer.
Note:  To administer the BlackBerry Enterprise Server, you must install the BlackBerry Administration Service. You can install
the BlackBerry Administration Service on the computer that hosts the BlackBerry Enterprise Server or on a separate computer.
The first BlackBerry Administration Service or BlackBerry Enterprise Server that you install creates and populates the BlackBerry
Configuration Database if you did not create the BlackBerry Configuration Database previously using the SQL scripts. You must
install the BlackBerry Administration Service if you create a BlackBerry Configuration Database and you must also either install
or upgrade the BlackBerry Administration Service on the computer that you perform the BlackBerry Enterprise Server installation
process on in the BlackBerry Domain first.

1. Log in to the computer using the Windows® account that you want the BlackBerry Enterprise Server services to run on.

2. In the BlackBerry Enterprise Server installation files, double-click setup.exe.

3. In the Setup type dialog box, select Create a BlackBerry Configuration Database.

4. In the Setup options dialog box, consider the following information:
• You can select or remove BlackBerry Enterprise Server components from the Additional Components list.
• To install the BlackBerry Administration Service only during the first installation, click Remote component. In the

Additional components list, expand BlackBerry administration. Click BlackBerry Adminstration Service.

5. When the setup application prompts you to restart the computer, click Yes.

6. Log in to the computer using the same account that you used in step 1.

7. In the Database information dialog box, perform the following actions:
• Specify the names of the database server and BlackBerry Configuration Database that the BlackBerry Enterprise Server

uses.

• If you configured the database server to use static ports, select the Static option. If the static port number is not 1433,
in the Port field, type the port number.
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8. In the Database mirroring options dialog box, if you want to configure database mirroring, select the Add support for
database mirroring check box and type the name of the database server that hosts the mirror database in the Name of
the mirror database server field. The setup application does not create the BlackBerry Configuration Database on the
mirror Microsoft® SQL Server®; it adds a registry key to the computer that includes the name of the mirror Microsoft SQL
Server.

9. In the CAL and SRP information dialog box, type the new SRP credentials.

10. In the Microsoft Exchange Server dialog box, perform the following actions:

a. In the Microsoft Exchange server field, type the name of the Microsoft® Exchange server.

b. In the Mailbox field, type the name of the administrator that has the appropriate permissions.

c. Click Check Name.

d. Click Apply.

e. Click OK.

11. In the Application extensibility settings dialog box, consider the following information:
• You can type an FQDN to create a new BlackBerry MDS Integration Service pool.
• To configure a hardware load-balancer for the BlackBerry MDS Integration Service pool, you can type an FQDN that

corresponds to a DNS record in the DNS server that maps the FQDN into the IP address of the virtual server that you
configured on the hardware load-balancer.

• You can create a new BlackBerry MDS Integration Service database or upgrade the existing BlackBerry MDS Integration
Service database.

• If you choose to create a new BlackBerry MDS Integration Service database, the setup application creates the BlackBerry
MDS Integration Service database on the same database server as the BlackBerry Configuration Database.

12. If you upgrade from the BlackBerry Collaboration Service for use with Windows® Messenger, in the Instant messaging
Settings dialog box, specify the Microsoft® Office Live Communications Server 2005 address.

13. In the Administration settings dialog box, perform the following actions:
• In the Pool name field, type an FQDN that the setup application can use to create the BlackBerry Administration Service

web address. If you install only one BlackBerry Administration Service instance in the BlackBerry Domain, you can accept
the default pool name. If you install more than one BlackBerry Administration Service instance in the BlackBerry Domain,
you must create a DNS entry for the pool name that is not the name of a computer and is mapped to the IP address of
each BlackBerry Administration Service instance.

• In the New password and Confirm password fields, type the password for the SSL certificate that the BlackBerry
Administration Service uses to authenticate with browsers. You must use the same password for every BlackBerry
Administration Service instance in the BlackBerry Domain.

14. In the Microsoft® Active Directory® settings dialog box, in the User password field, type the password for the Microsoft
Active Directory account (for example, BESAdmin) that the BlackBerry Enterprise Server uses to authenticate to Microsoft
Active Directory. If you want to specify a different user name and user domain, you must make sure that the user domain
belongs to the same Microsoft Active Directory forest as the Microsoft Exchange organization.
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If the setup application cannot locate any of the global catalog servers that are associated with the Microsoft Active Directory
account after you click the Next button, you must choose the global catalog servers that you want to add to the list manually.
To add a global catalog server to the list, click the Add button and select the appropriate server. Each global catalog server
that you add to the list must belong to the same domain as the Microsoft Active Directory user account.

15. In the Start services dialog box, do not start the BlackBerry Enterprise Server services.

16. Click Finish.

After you finish:
• If you configured the BlackBerry Administration Service instances in the pool to communicate across network subnets with

TCP before you upgraded BlackBerry Enterprise Server components, you must restore the configuration files. For more
information, visit www.blackberry.com/support to read article KB19654.

• Move user accounts to the BlackBerry Enterprise Server using the BlackBerry Enterprise Transporter. For more information
about moving user accounts, see the BlackBerry Enterprise Transporter Installation and Administration Guide.

Specifying a name for the BlackBerry Administration Service pool during the installation
process

During the installation process, the setup application prompts you to specify the name of the BlackBerry® Administration Service
pool.

The BlackBerry Administration Service instances use the pool name for interprocess communication and when you configure
BlackBerry Administration Service high availability using DNS round robin. You must specify a valid DNS host name during the
installation process, even if you do not configure BlackBerry Administration Service high availability using DNS round robin.

The setup application uses the FQDN of the computer that you install the first BlackBerry Administration Service instance on as
the default value for the pool name. If you keep the default value and configure BlackBerry Administration Service high availability
using DNS round robin at a later time, you must use the BlackBerry Configuration Panel to change the pool name to the host
name for the pool.

The name for the BlackBerry Administration Service pool does not impact BlackBerry Administration Service high availability
that uses a hardware load balancer.

For more information about BlackBerry Administration Service high availability, see the BlackBerry Enterprise Server Planning
Guide.
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Upgrading the BlackBerry Enterprise Server software in
phases

9

Using the phased upgrade process, you can maintain previous versions of the BlackBerry® Enterprise Server software, install
additional BlackBerry Enterprise Server instances over time, and move user accounts to the latest BlackBerry Enterprise Server
versions.

When you use the in-place upgrade process, all BlackBerry devices receive new IT policies. BlackBerry devices that are running
BlackBerry® Device Software version 4.0 or later receive new service books and wireless data synchronization occurs.

Advantages of this upgrade process include:
• You can move user accounts to the new BlackBerry Enterprise Server instances gradually to limit the number of service

books and IT policies that the BlackBerry Policy Service sends to BlackBerry devices at the same time.
• You can monitor system performance as you add user accounts.
• You can change your organization's environment during the upgrade process by changing which user accounts you associate

with each BlackBerry Enterprise Server instance.

Disadvantages of this upgrade process include:
• You require extra computers.
• You require additional SRP credentials.
• If you move user accounts from one BlackBerry Configuration Database to another, you lose the BlackBerry device options

that you backed up in the BlackBerry Configuration Database.
• You cannot use some new features (for example, one-to-many relationships between a BlackBerry MDS Connection Service

or BlackBerry Collaboration Service and multiple BlackBerry Enterprise Server instances) in the BlackBerry Enterprise Server
until all BlackBerry Enterprise Server components are the same version.

Upgrade multiple BlackBerry Enterprise Server instances in phases
You can upgrade the BlackBerry® Enterprise Server instances in your organization's environment in phases to minimize the
impact on users.

Before you begin: If you want to create a new BlackBerry Configuration Database, instruct users to back up their BlackBerry
devices. Any BlackBerry device options that are stored in the existing BlackBerry Configuration Database are deleted when you
add user accounts to the new BlackBerry Configuration Database.

1. Install the latest BlackBerry Enterprise Server version with the BlackBerry Administration Service on a separate computer.

2. If you create a new BlackBerry Configuration Database, create roles, administrator accounts, groups, IT policies, and software
configurations for your organization's environment.

3. If you upgrade an existing BlackBerry Configuration Database, remove BlackBerry Manager instances from your
organization's environment.
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4. Move user accounts to the upgraded BlackBerry Enterprise Server by performing one of the following actions:
• To upgrade an existing BlackBerry Configuration Database, move user accounts using the BlackBerry Administration

Service.
• To create a new BlackBerry Configuration Database, move user accounts using the BlackBerry Enterprise Transporter.

5. Upgrade instances of the central push server for the BlackBerry MDS Connection Service.

6. Upgrade the earlier BlackBerry Enterprise Server version using an in-place upgrade process. You can use the upgraded
BlackBerry Enterprise Server instance as the destination for user accounts that you move from earlier BlackBerry Enterprise
Server versions.

7. Move user accounts to the upgraded BlackBerry Enterprise Server instances, and upgrade the old BlackBerry Enterprise
Server instances until all BlackBerry Enterprise Server instances are running the latest software version.

After you finish: To enable BlackBerry device users to access the features that are part of the latest version, upgrade the
BlackBerry® Device Software. For more information, see the BlackBerry Device Software Update Guide.

Upgrade a standalone BlackBerry Router
Note:  You cannot manage the BlackBerry® Controller that monitors a standalone BlackBerry Router in the BlackBerry
Administration Service. You must manage the BlackBerry Controller in the BlackBerry Configuration Panel on the computer that
hosts the standalone BlackBerry Router.

1. Log in to the computer using the Windows® account that you want to use to run the BlackBerry Router.

2. In the BlackBerry® Enterprise Server installation files, double-click Setup.exe.

3. In the Setup type dialog box, select Upgrade the BlackBerry Router and BlackBerry Controller on this computer but
do not install other BlackBerry Enterprise Server components.

4. Start the services for the BlackBerry Router.
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Postupgrade tasks 10

Restore the BlackBerry MDS Connection Service configuration files
You can use the BlackBerry® MDS Connection Service configuration files, MdsLogin.conf and krb5.conf, to configure how the
BlackBerry MDS Connection Service authenticates BlackBerry devices with content servers that use NTLM or Kerberos™. The
BlackBerry MDS Connection Service configuration files are located in  <drive>:\Program Files\Research In Motion\BlackBerry
Enterprise Server\MDS\Servers\Instance\config.

When you upgrade a BlackBerry® Enterprise Server, the setup application creates new MdsLogin.conf or krb5.conf files and
creates backup versions of the old BlackBerry MDS Connection Service configuration files in the same location. If you changed
the MdsLogin.conf or krb5.conf files before you perform the upgrade, you should restore the backup versions of the files so that
the BlackBerry MDS Connection Service can authenticate BlackBerry devices with the content servers that use NTLM or Kerberos.

Upgrade the BlackBerry database notification system
The BlackBerry® database notification system is designed to reduce the number of database queries that a BlackBerry® Enterprise
Server makes to the BlackBerry Configuration Database.

If you upgrade the BlackBerry Configuration Database on the computer that hosts the BlackBerry Enterprise Server, the BlackBerry
database notification system upgrades automatically.

If you upgrade the BlackBerry Configuration Database on a database server that you installed on a computer that is not the
computer that hosts the BlackBerry Enterprise Server, you can upgrade the BlackBerry database notification system manually
after you complete the BlackBerry Enterprise Server installation process.

Before you begin:
• You must have the system administrator permission for the database.
• The database server must run on Windows Server® 2003.

1. On the database server, open the BlackBerry Enterprise Server installation files.

2. Perform one of the following actions:
• If a 32-bit Microsoft® SQL Server® 2005 is running in your organization's environment, in the Tools\DBNS\x86 folder,

copy the RimEsp.dll file to C:\Program Files\Microsoft SQL Server\MSSQL\Binn.
• If a 64-bit Microsoft SQL Server 2005 is running in your organization's environment, in the Tools\DBNS\x64 folder,

copy the RimEsp.dll file to C:\Program Files\Microsoft SQL Server\MSSQL\Binn.

3. Open the Microsoft SQL Server Management Studio.

4. Using the Microsoft SQL Server Management Studio, navigate to Database\DBInstallScripts\SQLServer\5.0 in the
BlackBerry Enterprise Server installation files.

5. Open the NotifyMasterInstall.sql file.
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6. Run the script.

7. Open the NotifyInstall.sql file.

8. Change <_DATABASENAME_> to the name of the BlackBerry Configuration Database (for example, BesMgmt).

9. Run the script.

10. Confirm that the Microsoft SQL Server Management Studio displays the "Function dbo.xp_RIMxxxx registered" message.

11. To add additional BlackBerry Configuration Database instances in your organization's environment, repeat steps 7 to 10.

12. Restart the database server and the computer that hosts the BlackBerry Enterprise Server.

Best practice: Running the BlackBerry Enterprise Server

Best practice Description

Do not change the startup type for the

BlackBerry® Enterprise Server services.

When you install or upgrade the BlackBerry Enterprise Server, the setup application

configures the startup type for the BlackBerry Enterprise Server services to

automatic or manual. For example, the setup application configures the startup type

for the BlackBerry Mail Store Service, BlackBerry Policy Service, and BlackBerry

Synchronization Service to manual.

To avoid errors in the BlackBerry Enterprise Server, do not change the startup type

for the BlackBerry Enterprise Server services.

Do not change the account information

for BlackBerry Enterprise Server

services.

When you install or upgrade the BlackBerry Enterprise Server, the setup application

configures the account information for the BlackBerry Enterprise Server services.

Do not change the account information for the BlackBerry Enterprise Server unless

the BlackBerry Enterprise Server documentation specifies that you can.

Run the BlackBerry Configuration Panel

as an administrator.

Consider the following guidelines if you are running the BlackBerry Configuration

Panel on Windows Server® 2008:

• Log in to the computer with a user account that is in the Administrator group

on the Windows Server.

• Right-click the BlackBerry Configuration Panel icon and click Run as

administrator.
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Configure support for Unicode languages
You can make sure that the messaging application can display the Unicode messages that the BlackBerry® device sends by
configuring the BlackBerry® Enterprise Server to support Unicode languages (for example, Japanese, Korean, or Simplified
Chinese).

1. On the computer that hosts the BlackBerry Enterprise Server, on the taskbar, click Start > Run.

2. Type regedit.

3. Click OK.

4. Perform one of the following actions:
• If you are running a 32-bit version of Windows, go to HKEY_LOCAL_MACHINE\SOFTWARE\Research In Motion

\BlackBerry Enterprise Server\Agents.
• If you are running a 64-bit version of Windows, go to HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Research

In Motion\BlackBerry Enterprise Server\Agents.

5. If the MAPIEncoding registry key exists, perform one of the following actions:
• Delete the key.
• Change the value of the key to 1.

6. Perform one of the following actions:
• If you are running a 32-bit version of Windows, go to HKEY_LOCAL_MACHINE\SOFTWARE\Research In Motion

\BlackBerry Enterprise Server\Setup.
• If you are running a 64-bit version of Windows, go to HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Research

In Motion\BlackBerry Enterprise Server\Setup.

7. Verify that the ConfigKeystoreCountry registry key is set to one of the following values, depending on your organization's
environment:
• CN for Simplified Chinese
• JP for Japanese
• KR for Korean

8. In the Windows® Services, restart the BlackBerry Dispatcher.

Configure support for Unicode text in calendars on BlackBerry devices in a
Microsoft Exchange 2003 environment
Before you begin: You must install the hotfixes for wireless calendar synchronization for Microsoft® Exchange 2003.

1. On the BlackBerry® Enterprise Server, on the Start menu, click Run.

2. Type regedit.

3. Click OK.
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4. Perform one of the following actions:
• If you are running a 32-bit version of Windows®, navigate to HKEY_LOCAL_MACHINE\Software\Research In Motion

\BlackBerry Enterprise Server\Agents.
• If you are running a 64-bit version of Windows, navigate to HKEY_LOCAL_MACHINE\Software\WOW6432Node

\Research In Motion\BlackBerry Enterprise Server\Agents.

5. Create a DWORD value that is named SetLocaleIDs.

6. Set the value to 1.

7. In the Windows® Services, restart the BlackBerry Messaging Agent.

Configure the BlackBerry Administration Service instances in the pool to
communicate across network subnets
The instances in the BlackBerry® Administration Service pool use multicast UDP to communicate with each other. If the BlackBerry
Administration Service instances are in different network subnets and your organization's network configuration does not permit
multicast UDP across the network subnets, you must configure the BlackBerry Administration Service instances to use TCP to
communicate with each other. For example, if your organization uses a UDP peer-to-peer firewall filter, you must configure the
BlackBerry Administration Service instances to communicate across network subnets.

For more information, visit www.blackberry.com/support to read article KB19654.

1. On the computer that hosts a BlackBerry Administration Service instance, navigate to  <drive>:\Program Files\Research In
Motion\BlackBerry Enterprise Server\BAS\jboss\ejb\server\default\deploy.

2. In a text editor, open cluster-service.xml and ejb3-entity-cache-service.xml.

3. Follow the instructions in the files to configure TCP.

4. Save and close the files.

5. Navigate to  <drive>:\Program Files\Research In Motion\BlackBerry Enterprise Server\BAS\server\default\deploy.

6. In a text editor, open bas-object-versioning-cache-service.xml and bas-clustered-cache-service.xml.

7. Follow the instructions in the files to configure TCP.

8. Save and close the files.

9. In the Windows® Services, restart the BlackBerry Administration Service services.

Log in to the BlackBerry Administration Service for the first time
To open the BlackBerry® Administration Service, you can use a browser on any computer that has access to the computer that
hosts the BlackBerry Administration Service.

Before you begin: To manage a BlackBerry device using the BlackBerry Administration Service while the BlackBerry device is
connected to the computer, the browser must permit Microsoft® ActiveX® controls.
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1. In the browser, type https://<server_name>/webconsole/app, where <server_name> is the name of the computer that
hosts the BlackBerry Administration Service.

2. In the User name field, type admin.

3. In the Password field, type the password that you created during the installation process.

4. In the Log in using drop-down list, click BlackBerry Administration Service.

5. Click Log in.

There is a problem with this website's security certificate
Description
The browser displays this error message when you try to navigate to the BlackBerry® Administration Service or BlackBerry
Monitoring Service using Windows® Internet Explorer® version 7 or later.

Possible solution
Add the web address for the BlackBerry Administration Service or BlackBerry Monitoring Service to the list of trusted web sites
in Windows Internet Explorer, and install the certificate for the BlackBerry Administration Service or BlackBerry Monitoring Service
in the certificate store of your computer.

1. In Windows Internet Explorer, navigate to the BlackBerry Administration Service console or BlackBerry Monitoring Service
console.

2. Click Continue to this website (not recommended).

3. On the Tools menu, click Internet Options.

4. On the Security tab, click Trusted Sites.

5. Click Sites.

6. Click Add to add the console to the list of trusted web sites.

7. Click Close.

8. Click OK.

9. In the browser window, on the toolbar, click Certificate Error.

10. Click View certificates.

11. Click Install certificate. The Certificate Import Wizard opens.

12. Complete the instructions in the Certificate Import Wizard. If you are trying to log in to the BlackBerry Administration Service
or BlackBerry Monitoring Service using a computer that runs Windows Vista™, perform the following actions in the Certificate
Import Wizard.

a. In the Certificate Store dialog box, click Place all certificates in the following store.

b. Click Browse.

c. Click Trusted Root Certification Authorities.

d. Click OK.
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13. Close and reopen the browser.

Configuring BlackBerry MDS Integration Service high availablility during the
upgrade process
The setup application creates a separate pool for each BlackBerry® MDS Integration Service instance that you upgrade. You
cannot add the upgraded BlackBerry MDS Integration Service instances to a pool so that you can configure high availability. You
can configure high availability only for new BlackBerry MDS Integration Service instances that you install.

You can consider upgrading a BlackBerry MDS Integration Service instance to the latest version if one of the following conditions
apply:
• Your organization uses the BlackBerry MDS Integration Service as a standalone service and does not have plans to configure

BlackBerry MDS Integration Service high availability.
• Your organization plans to configure BlackBerry MDS Integration Service high availability and the existing BlackBerry MDS

Integration Service version 4.1 instance is installed on a computer that does not have other software (for example, a database
server or third-party applications) installed on it.

If your organization plans to configure BlackBerry MDS Integration Service high availability, you must upgrade the BlackBerry
MDS Integration Service version 4.1 instance as the first instance in the BlackBerry MDS Integration Service pool. You must use
the FQDN of the computer that hosts the BlackBerry MDS Integration Service instance as the virtual name of the BlackBerry
MDS Integration Service pool.

If one of the above conditions do not apply, you can consider installing the latest BlackBerry MDS Integration Service version on
new computers. When you do so, after installing the BlackBerry MDS Integration Service instances, you must republish the
BlackBerry® MDS Runtime Applications.

Install a BlackBerry MDS Integration Service pool in an upgraded environment
When you install new BlackBerry® MDS Integration Service instances in an upgraded environment instead of upgrading existing
BlackBerry MDS Integration Service instances, you lose backend notification subscriptions. BlackBerry devices that run
BlackBerry® MDS Runtime Application versions earlier than version 4.5 remove the applications.

1. Install all BlackBerry MDS Integration Service instances in the pool.

2. Publish all existing BlackBerry MDS Runtime Applications.

3. Install all BlackBerry MDS Runtime Applications on a test BlackBerry device.

4. To migrate users from BlackBerry MDS Integration Service version 4.1 to the new BlackBerry MDS Integration Service pool,
in the BlackBerry Administration Service, update the BlackBerry Enterprise Server to associate with the new BlackBerry
MDS Integration Service pool.

After you finish:
• Configure backend notification subscriptions.

Upgrade Guide Configuring BlackBerry MDS Integration Service high availablility during the upgrade process

60



• Resend applications to BlackBerry devices that run BlackBerry MDS Runtime Application versions earlier than version 4.5.
• For more information, see the BlackBerry Enterprise Server Installation Guide.

Change applications to support BlackBerry MDS Connection Service failover
In earlier versions of the BlackBerry® Enterprise Server, an organization's push applications connected to only one instance of
the BlackBerry MDS Connection Service central push server. You must make sure that your organization's applications can access
all central push servers.

1. Change the applications to access central push servers only, and not BlackBerry MDS Connection Service instances that
administrators have not configured to also act as central push servers.

2. To change your organization's applications to support central push server failover, perform one of the following actions:
• Configure an HTTP or HTTPS proxy server that applications send requests through. Use this option if the applications

are located on the Internet. Optionally, you can place the proxy server in the DMZ.
• Configure the application servers to use a list of IP addresses to find an available central push server. If a central push

server does not respond to a request, the application can try to connect to another central push server.
• Configure a hardware load balancer. The load balancer accepts all requests from the application servers, and distributes

the traffic to the various central push servers. If a central push server does not respond, the load balancer redistributes
the requests to the remaining central push servers.

• Configure the application to use the new HTTP response header x-rim-push-gateways.

Configuring support for new attachments

Configure an upgraded BlackBerry Enterprise Server to support new attachment extensions
When you upgrade a BlackBerry® Enterprise Server instance, the upgrade process does not automatically add the new attachment
extensions that the latest BlackBerry Enterprise Server version supports. You must add the new attachment extensions after the
upgrade process completes so that the BlackBerry Enterprise Server can recognize the new attachment extensions and send
them to a BlackBerry Attachment Service instance for processing. The following list of supported file formats were added to
versions later than BlackBerry Enterprise Server version 4.1 SP3: .amr*, .wma, .pptx, .docx, .xlsx, .odp, .ods, .odt, .ott, .odp, and .ods
files.

1. In the BlackBerry Administration Service, on the Servers and components menu, expand BlackBerry Solution topology
> BlackBerry Domain > Component view > Attachment > Connector.

2. Click the BlackBerry Attachment Connector instance for the BlackBerry Enterprise Server.

3. Click Edit instance.

4. Click Supported Attachment Server instances.

5. For the BlackBerry Attachment Service instance that you want the BlackBerry Enterprise Server to send new attachments
to, click the Edit icon.

6. Add the new attachment extensions to the attachment extensions list.
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7. Click Save all.

Configure an upgraded BlackBerry Attachment Service to support new attachment distillers
During the upgrade process for a BlackBerry® Attachment Service instance, the setup application does not turn on the new
attachment distillers automatically. If you want the BlackBerry Attachment Service to process new attachments, you must turn
on the attachment distillers for these file formats. The following supported file formats were added to versions later than BlackBerry
Enterprise Server version 4.1 SP3: .amr*, .wma, .pptx, .docx, .xlsx, .odp, .ods, .odt, .ott, .ods, and .odp files.

1. In the BlackBerry Administration Service, on the Servers and components menu, expand BlackBerry Solution topology
> BlackBerry Domain > Component view > Attachment > Server.

2. Click the instance that you upgraded.

3. Click Edit instance.

4. In the Distiller section, in the Allowed column, turn on the attachment distillers that you want the BlackBerry Attachment
Service to support.

5. If required, in the Distiller section, in the Attachment size (KB) column, change the attachment size, in KB, for the new
attachments.

6. Click Save.

Assigning an IT policy to a group
After you complete the upgrade process, you can assign an IT policy to a group. When you assign an IT policy to a group, the
BlackBerry® Enterprise Server can assign the IT policy to each user account in the group. However, if an IT policy is already
assigned to a user account in a group, the BlackBerry Enterprise Server sends the IT policy that is assigned to the user account
to the BlackBerry device. To use the IT policy that is assigned to the group, you must remove the IT policy that is assigned to the
user account.

Remove an IT policy from a user account

Before you begin: Assign an IT policy to a group that includes the user account.

1. In the BlackBerry® Administration Service, on the BlackBerry solution management menu, expand User.

2. Click Manage users.

3. Search for the user account.

4. Click the user account.

5. On the Policies tab, click Edit user.

6. In the drop-down list, click the blank option (the first entry in the drop-down list) to remove the IT policy.

7. Click Save all.
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After you finish: Resend the IT policy to the user account.

Restrict database permissions for the BlackBerry Attachment Service
The BlackBerry® Attachment Service accesses the BlackBerry Configuration Database to read attachment data using a Windows®
account or a SQL authentication account. To limit the access that the BlackBerry Attachment Service account has to the tables
in the BlackBerry Configuration Database, you can configure a BlackBerry Attachment Service account that has limited database
permissions. This account is not the same as the account that the BlackBerry® Enterprise Server uses to access the BlackBerry
Configuration Database.

Before you begin:
• Create a Windows® account for the BlackBerry Attachment Service.
• To use database authentication, create a SQL authentication account for the BlackBerry Attachment Service.

1. In the Microsoft® SQL Server® management console, create a SQL login for the Windows account or SQL authentication
account.

2. Assign the account to the rim_db_AttachmentServer role in the BlackBerry Configuration Database.

3. If you want the BlackBerry Attachment Service to use a SQL authentication account to access the BlackBerry Configuration
Database, perform the following actions:

a. On the computer that you installed the BlackBerry Attachment Service on, log in using the Windows account that the
BlackBerry Attachment Service is running on.

b. Click Start > Run.

c. Type regedit. Click OK.

d. If you are running a 32-bit version of Windows, navigate to HKEY_CURRENT_USER\SOFTWARE\Research In Motion.

e. If you are running a 64-bit version of Windows, navigate to HKEY_CURRENT_USER\SOFTWARE\WOW6432Node
\Research In Motion.

f. Create the BBAttachServer\Database keys.

g. In the Database key, create the Login and Password string values for the SQL authentication account.

After you finish: After you complete the BlackBerry Attachment Service installation process, in the Windows Services, verify that
the service for the BlackBerry Attachment Service is using the Windows account that you configured. If you need to change the
account information, restart the BlackBerry Attachment Service.

Upgrade Guide Restrict database permissions for the BlackBerry Attachment Service

63



Configuring minimum Microsoft SQL Server permissions for the Windows
account
The BlackBerry® Enterprise Server setup application requires the Windows® account that it uses during the installation process
or upgrade process to have Microsoft® SQL Server® permissions to create or upgrade the BlackBerry Configuration Database.
The setup application requires the Windows account to have more Microsoft SQL Server permissions to install the BlackBerry
Enterprise Server than the BlackBerry Enterprise Server requires to run.

After the installation or upgrade process completes, you can change the Microsoft SQL Server permissions of the Windows account
to the Microsoft SQL Server permissions that the BlackBerry Enterprise Server requires to run. When you change the Microsoft
SQL Server permissions of the Windows account, you can use Microsoft SQL Server security to minimize the operations that the
Windows account can perform on the BlackBerry Configuration Database.

The following table describes the Microsoft SQL Server permissions for the setup application and the Windows account that the
BlackBerry Enterprise Server uses to run.

Server and database roles Description

db_owner The setup applicaton requires this role to install and upgrade the BlackBerry

Configuration Database, BlackBerry MDS Integration Service database, and

BlackBerry Monitoring Service database.

You can remove this role from the Windows account that the BlackBerry Enterprise

Server uses to run after the setup application creates or upgrades the BlackBerry

Configuration Database.

rim_db_bes_server The BlackBerry Enterprise Server requires this role to run the BlackBerry Enterprise

Server services. The setup application or the createDB executable creates the role

automatically when it creates the BlackBerry Configuration Database.

This role is the minimum Microsoft SQL Server permission for running the BlackBerry

Enterprise Server.

Configure minimum Microsoft SQL Server permissions for the Windows account
You can configure the minimum Microsoft® SQL Server® permissions for the Windows® account that the BlackBerry® Enterprise
Server uses to run.

1. Open the Microsoft SQL Server console.

2. Expand Microsoft SQL Server > Security > Logins.
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3. Right-click the Windows account that the BlackBerry Enterprise Server uses to run. Click Properties.

4. Map the Windows account to the BlackBerry Configuration Database.

5. Change the Database role membership to rim_db_bes_server.

6. Remove all other database role memberships.

7. Apply your changes.

Configuring a computer for monitoring

Configure the SNMP service for monitoring
You can configure the SNMP service on the computer that hosts the BlackBerry® Enterprise Server so that the BlackBerry
Monitoring Service can monitor BlackBerry Enterprise Server activity.

Before you begin: Verify that the SNMP service is installed and running.

1. On a computer that hosts the BlackBerry Enterprise Server or BlackBerry Enterprise Server components, in the Windows®
Services, right-click SNMP Service. Click Properties.

2. On the General tab, change the startup type to Automatic.

3. On the Traps tab, in the Community name field, type the community name for the SNMP service. The field is case-sensitive.

4. In the Trap Destinations section, add the IP address of the computer that hosts the BlackBerry Monitoring Service.

5. On the Security tab, in the Accepted community names section, add the community name that you typed in step 3. The
SNMP community name is read-only.

6. Select the Accept SNMP packets from any host or Accept SNMP packets from these hosts option, depending on your
organization's environment.

7. If you selected Accept SNMP packets from these hosts, type the IP address of the computer that hosts the BlackBerry
Monitoring Service.

8. Click Apply.

9. In the Services list, right-click SNMP Service. Click Restart.

Configure the BlackBerry Monitoring Service to monitor a BlackBerry Enterprise Server

Before you begin: Verify that the computer that hosts the BlackBerry® Enterprise Server has access to the computer that hosts
the BlackBerry Monitoring Service.

1. In a browser, type https://<server_name>:8443/webconsole/app, where <server_name> is the FQDN of the computer
that hosts the BlackBerry Monitoring Service.

2. Log in as an administrator that has permissions to access the BlackBerry Monitoring Service.

3. On the Configuration menu, expand Servers.
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4. Click Manage Servers.

5. Click the Edit icon for the BlackBerry Enterprise Server that you want the BlackBerry Monitoring Service to monitor.

6. In the SNMP Configuration section, type the SNMP port number that the SNMP service on the BlackBerry Enterprise
Server computer uses.

7. In the SNMP Configuration section, type the SNMP community name that the SNMP service on the BlackBerry Enterprise
Server computer uses.

8. In the SNMP Configuration section, select the Monitoring status check box.

9. Click Save.
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Troubleshooting the BlackBerry Enterprise Server upgrade
process

11

Failed to write License Key to the Database
This error message appears when you try to add the BlackBerry® Client Access License key during the installation process.

Possible solution
After you restart the computer during the BlackBerry® Enterprise Server installation process, you must log in using the same
Windows® account that you used to start the installation process.

1. Close the setup application.

2. Log out of the computer.

3. Log in to the computer.

4. Restart the setup application.

Previous version detected but no database available
This error message appears when you cannot start the setup application or the setup application stops responding.

Possible solution
Verify that the registry keys that identify the BlackBerry® Configuration Database exist in the Windows® registry.

1. On the computer that you want to install or upgrade the BlackBerry® Enterprise Server on, on the Start menu, click Run.

2. Type regedit.

3. Click OK.

4. In the left pane, navigate to HKEY_LOCAL_MACHINE\Software\Research In Motion\BlackBerry Enterprise Server
\Database.

5. If necessary, create case-sensitive strings that you name DatabaseName and DatabaseServerMachineName.

6. Specify the name of the BlackBerry Configuration Database as the value for DatabaseName.

7. Specify the FQDN name of the database server as the value for DatabaseServerMachineName.

8. Restart the setup application.

Upgrade Guide Troubleshooting the BlackBerry Enterprise Server upgrade process

67



You encounter errors when you try to upgrade the BlackBerry Configuration
Database
Possible solution

1. Navigate to C:\Program Files\Research In Motion\BlackBerry Enterprise Server\Logs\Installer or to the location of the log
files that you specified in the setup application.

2. Open DB_InstallV<YYMMDDHHMMSS>.log, where <YYMMDDHHMMSS> specifies the date and time, in 24 hour clock
format, that you upgraded the BlackBerry® Configuration Database.

3. Check the log file for error messages.

You cannot resolve errors that occur when you move users
Possible solution

1. Delete the user accounts from the BlackBerry® Enterprise Server before you start the upgrade process.

2. Add the user accounts to the BlackBerry Enterprise Server when the upgrade process completes.

3. Activate users’ BlackBerry devices over the wireless network.

A third-party tool did not install and the BlackBerry Enterprise Server setup
application closed
Possible solution

1. On the BlackBerry® Enterprise Server installation media, open the Tools folder.

2. Double-click the setup application file for the tool that you want to install.

3. Complete the instructions on the screen.

4. Restart the BlackBerry Enterprise Server setup application.

The BlackBerry Collaboration Service does not connect to Microsoft Office
Live Communications Server 2005
Possible solution
If the instant messaging in your organization's environment supports Windows® Messenger with TLS, you must configure
authentication.
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1. Download the trial edition of Microsoft® Office Communicator 2005 from www.microsoft.com/downloads.

2. Install Microsoft Office Communicator 2005 on the computer that hosts the BlackBerry® Collaboration Service.

3. Connect to Microsoft® Office Live Communications Server 2005 using Microsoft Office Communicator 2005.

4. If a connection does not open, verify that you installed or imported the certificates that are required for authentication.

The setup application did not prompt you to change or confirm the MAPI
profile
Possible solution
Create and change the MAPI profile manually.

1. On the BlackBerry® Enterprise Server installation media, open the Tools folder.

2. Double-click the Fixmapisvc.exe file.

3. Verify that mapisvc.inf is installed in C:\winnt\system32\ or C:\windows\system32\.

4. On the taskbar, click Start > BlackBerry Enterprise Server > Edit MAPI Profile.

5. Type the Microsoft® Exchange server name.

6. Click the Windows® account that is associated with the MAPI profile.

7. Click OK.

The BlackBerry Monitoring Service cannot monitor events
Possible cause
The SNMP service was not installed before the BlackBerry® Enterprise Server software was installed.

Possible solution
To permit the BlackBerry Monitoring Service to monitor a BlackBerry Enterprise Server activity, you can install the SNMP service
on the computer after you install a BlackBerry Enterprise Server.

1. Verify that the computer has access to the Windows® installation media.

2. On the computer that hosts the BlackBerry Enterprise Server or BlackBerry Enterprise Server components, on the taskbar,
click Start > Settings > Control Panel > Add/Remove Programs > Add/Remove Windows Components.

3. Double-click Management and Monitoring Tools.

4. Select the Simple Network Management Protocol check box.

5. Click OK.

6. When the installation wizard prompts you, install the files from the Windows installation media.

7. Complete the installation wizard.
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To complete the installation process, configure the SNMP service to monitor the BlackBerry Enterprise Server activity.

Restore a BlackBerry Configuration Database
If you created a copy of the BlackBerry® Configuration Database using the CreateDB tool, you can restore the copy if you determine
that the upgrade process did not complete successfully.

1. In the Windows® Services, stop the BlackBerry® Enterprise Server services.

2. On the server that hosts the BlackBerry Configuration Database, open a command prompt window.

3. Change to  <extractedfolder>\Tools.

4. Type BlackBerryDBRestore.exe.

5. Type the same parameters that you used when you backed up the BlackBerry Configuration Database.

6. Press ENTER.

Users experience unexpected behavior with message lists and calendars on
BlackBerry devices
Possible cause
If the MAPI and CDO client version 6.5.8022 was installed without uninstalling previous versions of the MAPI and CDO client
(including the associated .DLL files), users might experience unexpected behavior with message lists and calendars on
BlackBerry® devices.

Possible solution
For more information about Microsoft® Exchange Server MAPI Client and CDO version 1.2.1, visit www.microsoft.com.

1. In the Windows® Services, stop the services for the BlackBerry® Enterprise Server and any processes that use the MAPI and
CDO client.

2. Remove the MAPI and CDO client version 6.5.8022.

3. Verify that the following files are not present in C:\Windows\System32 or any other directory in the environment path:
• CDO.DLL
• EMSABP32.DLL
• EMSMDB32.DLL
• EMSUI32.DLL
• EMSUIX32.DLL
• GAPI32.DLL
• MAPISP32.EXE
• MSPST32.DLL
• WMSUI32.DLL
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4. In C:\Windows\System32, run the FixMapi.exe application.

5. Install the MAPI and CDO client version 6.5.8022.

6. Restart the services for the BlackBerry Enterprise Server and any processes that use the MAPI and CDO client.

If you run the BlackBerry Enterprise Server setup application after you complete the possible solution, when the setup application
displays the preinstallation checklist, an error message indicates that the setup application could not detect the MAPI and CDO
client. The setup application displays this error message because you installed the MAPI and CDO client version 6.5.8022 in a
different directory than the directory that you installed it in for previous versions. The error mesage does not prevent the BlackBerry
Enterprise Server setup application from completing the installation process successfully.

Various BlackBerry Enterprise Server components do not start

Possible cause Possible solution

The BlackBerry® Administration Service,

BlackBerry MDS Connection Service,

BlackBerry MDS Integration Service, or

BlackBerry Collaboration Service is

configured to use a dynamic port when

it connects to the BlackBerry

Configuration Database, but the

database server uses a static port.

Configure a static port for the BlackBerry Configuration Database.

1. On the computer that hosts the BlackBerry® Enterprise Server component, on

the taskbar, click Start > Programs > BlackBerry Enterprise Server >

BlackBerry Server Configuration.

2. On the Database Connectivity tab, clear the Use dynamic ports or specify

SQL port check box.

3. Type the port number in the Use dynamic ports or specify SQL port field.

4. Click OK.

5. In the Windows® Services, restart the services for the BlackBerry Enterprise

Server component.

The BlackBerry Administration Service,

BlackBerry MDS Connection Service,

BlackBerry MDS Integration Service, or

BlackBerry Collaboration Service is

configured to use an incorrect static port

number when it connects to the

BlackBerry Configuration Database.

Configure the component to use the correct port number.

1. On the computer that hosts the BlackBerry Enterprise Server component, on

the taskbar, click Start > Programs > BlackBerry Enterprise Server >

BlackBerry Server Configuration.

2. Type the correct port number in the Use dynamic ports or specify SQL

port field.

3. Click OK.

4. In the Windows Services, restart the services for the BlackBerry Enterprise

Server component.
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You cannot access the BlackBerry Administration Service
Possible cause
The computer that hosts the BlackBerry® Administration Service has more than one NIC and the production NIC is not first in
the bind order in Windows® network settings as it must be for you to access the BlackBerry Administration Service.

Possible solution
On the computer that hosts the BlackBerry Administration Service, in the Windows network settings, verify that the production
NIC is first in the bind order. For more information, visit www.blackberry.com/support to read article KB18190.

You cannot create a user account in the BlackBerry Administration Service

Possible cause Possible solution

The BlackBerry® Administration Service

is configured to use static ports when it

connects to the BlackBerry

Configuration Database server, but the

BlackBerry Configuration Database

server uses a dynamic port.

Configure the BlackBerry Administration Service to use a dynamic port for the

BlackBerry Configuration Database.

1. On the computer that hosts the BlackBerry® Enterprise Server or BlackBerry

Enterprise Server components, on the taskbar, click Start > Programs >

BlackBerry Enterprise Server > BlackBerry Server Configuration.

2. On the Database Connectivity tab, select the Use dynamic ports or specify

SQL port check box.

3. Click OK.

4. In the Windows® Services, restart the services for the BlackBerry

Administration Service.

The BlackBerry Administration Service pool name is the same as the FQDN
of the host computer
Possible cause
A DNS record was not created before a BlackBerry® Administration Service instance was installed.

Possible solution
1. Create the DNS record for the BlackBerry Administration Service instance.
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2. On the computer that hosts the BlackBerry Administration Service instance, on the taskbar, click Start > Programs >
BlackBerry Enterprise Server > BlackBerry Server Configuration.

3. On the Administration Service - High Availability tab, in the Pool name field, type the name of the BlackBerry
Administration Service pool.

4. In the Windows® Services, restart the services for the BlackBerry Administration Service.
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Glossary 12

AES
Advanced Encryption Standard

AJAX
Asynchronous JavaScript® and XML

BlackBerry CAL
A BlackBerry® Client Access License (BlackBerry CAL) limits how many users you can add to a BlackBerry® Enterprise Server.

BlackBerry Domain
A BlackBerry Domain consists of the BlackBerry Configuration Database with its users and any BlackBerry® Enterprise Server
instances that connect to it.

BlackBerry Enterprise Server databases
The BlackBerry® Enterprise Server databases are the BlackBerry Configuration Database, the BlackBerry MDS Integration
Service database, and the BlackBerry Monitoring Service database.

BlackBerry MDS
BlackBerry® Mobile Data System

CAS
Client Access Server

CDO
Collaboration Data Object

CDMA
Code Division Multiple Access

DMZ
A demilitarized zone (DMZ) is a neutral subnetwork outside of an organization's firewall. It exists between the trusted LAN
of the organization and the untrusted external wireless network and public Internet.

DNS
Domain Name System

FQDN
fully qualified domain name

HTTP
Hypertext Transfer Protocol
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HTTPS
Hypertext Transfer Protocol over Secure Sockets Layer

IIS
Internet Information Services

IP
Internet Protocol

IP address
An Internet Protocol (IP) address is an identification number that each computer or mobile device uses when it sends or
receives information over a network, such as the Internet. This identification number identifies the specific computer or
mobile device on the network.

JDK
Java® Development Kit

JRE
Java® Runtime Environment

LAN
local area network

LDAP
Lightweight Directory Access Protocol

MAPI
Messaging Application Programming Interface

messaging server
A messaging server sends and processes messages and provides collaboration services, such as updating and communicating
calendar and address book information.

MSDE
Microsoft® SQL Server® Desktop Engine

NIC
network interface card

RAID
redundant array of independent (or inexpensive) disks

SMS
Short Message Service
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SNMP
Simple Network Management Protocol

SQL
Structured Query Language

SRP
Server Routing Protocol

SSL
Secure Sockets Layer

TCP
Transmission Control Protocol

TCP/IP
Transmission Control Protocol/Internet Protocol (TCP/IP) is a set of communication protocols that is used to transmit data
over networks, such as the Internet.

TLS
Transport Layer Security

Triple DES
Triple Data Encryption Standard

XML
Extensible Markup Language

WAN
wide area network
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Provide feedback 13

To provide feedback on this deliverable, visit www.blackberry.com/docsfeedback.
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Legal notice 14

©2009 Research In Motion Limited. All rights reserved. BlackBerry®, RIM®, Research In Motion®, SureType®, SurePress™ and
related trademarks, names, and logos are the property of Research In Motion Limited and are registered and/or used in the U.S.
and countries around the world.

IBM, Lotus, and Sametime are trademarks of International Business Machines Corporation. Intel and Xeon are trademarks of
Intel Corporation. Kerberos is a trademark of the Massachusetts Institute of Technology. Microsoft, Active Directory, ActiveX,
Internet Explorer, Microsoft Exchange Server, Outlook, SQL Server, Windows, Windows Media, Windows Server, and Windows
Vista are trademarks of Microsoft Corporation. Novell and GroupWise are trademarks of Novell, Inc. RSA is a trademark of RSA
Security. Java, JavaScript, and JRE are trademarks of Sun Microsystems, Inc. VMware is a trademark of VMware, Inc. All other
trademarks are the property of their respective owners.

The BlackBerry smartphone and other devices and/or associated software are protected by copyright, international treaties, and
various patents, including one or more of the following U.S. patents: 6,278,442; 6,271,605; 6,219,694; 6,075,470; 6,073,318;
D445,428; D433,460; D416,256. Other patents are registered or pending in the U.S. and in various countries around the world.
Visit www.rim.com/patents for a list of RIM (as hereinafter defined) patents.

This documentation including all documentation incorporated by reference herein such as documentation provided or made
available at www.blackberry.com/go/docs is provided or made accessible "AS IS" and "AS AVAILABLE" and without condition,
endorsement, guarantee, representation, or warranty of any kind by Research In Motion Limited and its affiliated companies
("RIM") and RIM assumes no responsibility for any typographical, technical, or other inaccuracies, errors, or omissions in this
documentation. In order to protect RIM proprietary and confidential information and/or trade secrets, this documentation may
describe some aspects of RIM technology in generalized terms. RIM reserves the right to periodically change information that
is contained in this documentation; however, RIM makes no commitment to provide any such changes, updates, enhancements,
or other additions to this documentation to you in a timely manner or at all.

This documentation might contain references to third-party sources of information, hardware or software, products or services
including components and content such as content protected by copyright and/or third-party web sites (collectively the "Third
Party Products and Services"). RIM does not control, and is not responsible for, any Third Party Products and Services including,
without limitation the content, accuracy, copyright compliance, compatibility, performance, trustworthiness, legality, decency,
links, or any other aspect of Third Party Products and Services. The inclusion of a reference to Third Party Products and Services
in this documentation does not imply endorsement by RIM of the Third Party Products and Services or the third party in any way.

EXCEPT TO THE EXTENT SPECIFICALLY PROHIBITED BY APPLICABLE LAW IN YOUR JURISDICTION, ALL CONDITIONS,
ENDORSEMENTS, GUARANTEES, REPRESENTATIONS, OR WARRANTIES OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING
WITHOUT LIMITATION, ANY CONDITIONS, ENDORSEMENTS, GUARANTEES, REPRESENTATIONS OR WARRANTIES OF
DURABILITY, FITNESS FOR A PARTICULAR PURPOSE OR USE, MERCHANTABILITY, MERCHANTABLE QUALITY, NON-
INFRINGEMENT, SATISFACTORY QUALITY, OR TITLE, OR ARISING FROM A STATUTE OR CUSTOM OR A COURSE OF DEALING
OR USAGE OF TRADE, OR RELATED TO THE DOCUMENTATION OR ITS USE, OR PERFORMANCE OR NON-PERFORMANCE
OF ANY SOFTWARE, HARDWARE, SERVICE, OR ANY THIRD PARTY PRODUCTS AND SERVICES REFERENCED HEREIN, ARE
HEREBY EXCLUDED. YOU MAY ALSO HAVE OTHER RIGHTS THAT VARY BY STATE OR PROVINCE. SOME JURISDICTIONS
MAY NOT ALLOW THE EXCLUSION OR LIMITATION OF IMPLIED WARRANTIES AND CONDITIONS. TO THE EXTENT
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PERMITTED BY LAW, ANY IMPLIED WARRANTIES OR CONDITIONS RELATING TO THE DOCUMENTATION TO THE EXTENT
THEY CANNOT BE EXCLUDED AS SET OUT ABOVE, BUT CAN BE LIMITED, ARE HEREBY LIMITED TO NINETY (90) DAYS FROM
THE DATE YOU FIRST ACQUIRED THE DOCUMENTATION OR THE ITEM THAT IS THE SUBJECT OF THE CLAIM.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW IN YOUR JURISDICTION, IN NO EVENT SHALL RIM BE LIABLE
FOR ANY TYPE OF DAMAGES RELATED TO THIS DOCUMENTATION OR ITS USE, OR PERFORMANCE OR NON-
PERFORMANCE OF ANY SOFTWARE, HARDWARE, SERVICE, OR ANY THIRD PARTY PRODUCTS AND SERVICES REFERENCED
HEREIN INCLUDING WITHOUT LIMITATION ANY OF THE FOLLOWING DAMAGES: DIRECT, CONSEQUENTIAL, EXEMPLARY,
INCIDENTAL, INDIRECT, SPECIAL, PUNITIVE, OR AGGRAVATED DAMAGES, DAMAGES FOR LOSS OF PROFITS OR REVENUES,
FAILURE TO REALIZE ANY EXPECTED SAVINGS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, LOSS OF
BUSINESS OPPORTUNITY, OR CORRUPTION OR LOSS OF DATA, FAILURES TO TRANSMIT OR RECEIVE ANY DATA, PROBLEMS
ASSOCIATED WITH ANY APPLICATIONS USED IN CONJUNCTION WITH RIM PRODUCTS OR SERVICES, DOWNTIME COSTS,
LOSS OF THE USE OF RIM PRODUCTS OR SERVICES OR ANY PORTION THEREOF OR OF ANY AIRTIME SERVICES, COST OF
SUBSTITUTE GOODS, COSTS OF COVER, FACILITIES OR SERVICES, COST OF CAPITAL, OR OTHER SIMILAR PECUNIARY
LOSSES, WHETHER OR NOT SUCH DAMAGES WERE FORESEEN OR UNFORESEEN, AND EVEN IF RIM HAS BEEN ADVISED
OF THE POSSIBILITY OF SUCH DAMAGES.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW IN YOUR JURISDICTION, RIM SHALL HAVE NO OTHER
OBLIGATION, DUTY, OR LIABILITY WHATSOEVER IN CONTRACT, TORT, OR OTHERWISE TO YOU INCLUDING ANY LIABILITY
FOR NEGLIGENCE OR STRICT LIABILITY.

THE LIMITATIONS, EXCLUSIONS, AND DISCLAIMERS HEREIN SHALL APPLY: (A) IRRESPECTIVE OF THE NATURE OF THE
CAUSE OF ACTION, DEMAND, OR ACTION BY YOU INCLUDING BUT NOT LIMITED TO BREACH OF CONTRACT, NEGLIGENCE,
TORT, STRICT LIABILITY OR ANY OTHER LEGAL THEORY AND SHALL SURVIVE A FUNDAMENTAL BREACH OR BREACHES
OR THE FAILURE OF THE ESSENTIAL PURPOSE OF THIS AGREEMENT OR OF ANY REMEDY CONTAINED HEREIN; AND (B)
TO RIM AND ITS AFFILIATED COMPANIES, THEIR SUCCESSORS, ASSIGNS, AGENTS, SUPPLIERS (INCLUDING AIRTIME
SERVICE PROVIDERS), AUTHORIZED RIM DISTRIBUTORS (ALSO INCLUDING AIRTIME SERVICE PROVIDERS) AND THEIR
RESPECTIVE DIRECTORS, EMPLOYEES, AND INDEPENDENT CONTRACTORS.

IN ADDITION TO THE LIMITATIONS AND EXCLUSIONS SET OUT ABOVE, IN NO EVENT SHALL ANY DIRECTOR, EMPLOYEE,
AGENT, DISTRIBUTOR, SUPPLIER, INDEPENDENT CONTRACTOR OF RIM OR ANY AFFILIATES OF RIM HAVE ANY LIABILITY
ARISING FROM OR RELATED TO THE DOCUMENTATION.

Prior to subscribing for, installing, or using any Third Party Products and Services, it is your responsibility to ensure that your
airtime service provider has agreed to support all of their features. Some airtime service providers might not offer Internet browsing
functionality with a subscription to the BlackBerry® Internet Service. Check with your service provider for availability, roaming
arrangements, service plans and features. Installation or use of Third Party Products and Services with RIM's products and services
may require one or more patent, trademark, copyright, or other licenses in order to avoid infringement or violation of third party
rights. You are solely responsible for determining whether to use Third Party Products and Services and if any third party licenses
are required to do so. If required you are responsible for acquiring them. You should not install or use Third Party Products and
Services until all necessary licenses have been acquired. Any Third Party Products and Services that are provided with RIM's
products and services are provided as a convenience to you and are provided "AS IS" with no express or implied conditions,
endorsements, guarantees, representations, or warranties of any kind by RIM and RIM assumes no liability whatsoever, in relation
thereto. Your use of Third Party Products and Services shall be governed by and subject to you agreeing to the terms of separate
licenses and other agreements applicable thereto with third parties, except to the extent expressly covered by a license or other
agreement with RIM.
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Certain features outlined in this documentation require a minimum version of BlackBerry® Enterprise Server, BlackBerry® Desktop
Software, and/or BlackBerry® Device Software.

The terms of use of any RIM product or service are set out in a separate license or other agreement with RIM applicable thereto.
NOTHING IN THIS DOCUMENTATION IS INTENDED TO SUPERSEDE ANY EXPRESS WRITTEN AGREEMENTS OR WARRANTIES
PROVIDED BY RIM FOR PORTIONS OF ANY RIM PRODUCT OR SERVICE OTHER THAN THIS DOCUMENTATION.

Certain features outlined in this documentation might require additional development or Third Party Products and Services for
access to corporate applications.

Research In Motion Limited
295 Phillip Street
Waterloo, ON N2L 3W8
Canada

Research In Motion UK Limited 
Centrum House 
36 Station Road 
Egham, Surrey TW20 9LF 
United Kingdom 

Published in Canada

Upgrade Guide Legal notice

80


	Overview: BlackBerry Enterprise Server
	Planning a BlackBerry Enterprise Server upgrade
	Replacing the BlackBerry Manager with the BlackBerry Administration Service
	Synchronizing data over the wireless network automatically
	Upgrade implications for the BlackBerry Configuration Database
	Supported BlackBerry Enterprise Server versions that you can upgrade

	Hardware requirements: BlackBerry Enterprise Server
	System requirements
	System requirements: BlackBerry Enterprise Server
	System requirements: BlackBerry Administration Service and BlackBerry Web Desktop Manager
	System requirements: BlackBerry Enterprise Server databases
	System requirements: BlackBerry Attachment Service
	System requirements: BlackBerry Collaboration Service
	System requirements: BlackBerry MDS Connection Service
	System requirements: BlackBerry MDS Integration Service
	System requirements: BlackBerry Monitoring Service
	System requirements: BlackBerry Router
	System requirements: Computers for BlackBerry Web Desktop Manager, BlackBerry Administration Service, and BlackBerry Monitoring Service users
	System requirements: Messaging server
	System requirements: Firewall
	System requirements: Instant messaging server
	Supported features and environments
	Unsupported environments

	Preupgrade tasks
	Configuring a Microsoft Exchange 2010 messaging environment
	Create a Windows account that has a Microsoft Exchange 2010 mailbox
	Configure Microsoft Exchange 2010 permissions for the Windows account
	Turn off client throttling in Microsoft Exchange 2010
	Increase the maximum number of connections to the Address Book service in Microsoft Exchange 2010
	Configure a management role for Microsoft Exchange Web Services
	Configure the BlackBerry Enterprise Server to run without public folders

	Configuring a Microsoft Exchange 2007 messaging environment
	Create a Windows account that has a Microsoft Exchange 2007 mailbox
	Configure Microsoft Exchange 2007 permissions for the Windows account
	Permit BlackBerry device users to send email messages in a Microsoft Exchange environment

	Configuring a Microsoft Exchange 2003 messaging environment
	Create a Windows account that has a Microsoft Exchange 2003 mailbox
	Configure Microsoft Exchange 2003 permissions for the Windows account
	Permit BlackBerry device users to send email messages in a Microsoft Exchange environment

	Configure permissions for the Windows account
	Prevent the Microsoft Exchange known issues for wireless calendar synchronization
	Verify if the Windows account can access a user account in Microsoft Exchange
	Configuring connections for the BlackBerry Enterprise Server databases
	Specifying permissions when you connect to the BlackBerry Enterprise Server databases using Windows authentication or Microsoft SQL Server authentication
	Configuring authentication to the BlackBerry MDS Integration Service database

	Resolving IT policy and application control policy conflicts in a mixed version environment
	Resolve IT policy and application control policy conflicts in a mixed version environment

	Backing up the BlackBerry Configuration Database
	Back up the BlackBerry Configuration Database

	Migrating BlackBerry MDS Runtime Applications
	Migrate data from the BlackBerry MDS Integration Service discovery database to the BlackBerry MDS Integration Service database

	Install the SNMP service for monitoring by the BlackBerry Monitoring Service
	Creating a BlackBerry Administration Service pool using DNS round robin that includes the BlackBerry Web Desktop Manager
	Creating a BlackBerry MDS Integration Service pool
	Create the DNS record for a BlackBerry Administration Service instance or BlackBerry MDS Integration Service instance
	Applications that are installed with the BlackBerry Enterprise Server components
	Prerequisites: Upgrading the BlackBerry Enterprise Server software
	Performing a test upgrade of the BlackBerry Configuration Database
	Perform a test upgrade of the BlackBerry Configuration Database


	Upgrading the BlackBerry Enterprise Server software by using the in-place upgrade process
	Upgrade the BlackBerry Enterprise Server software by overwriting the existing version and use the existing BlackBerry Configuration Database
	Specifying a name for the BlackBerry Administration Service pool during the installation process

	Upgrade the BlackBerry Enterprise Server instances that you configured for disaster recovery

	Upgrading the BlackBerry Enterprise Server using the cutover upgrade process and upgrade the existing BlackBerry Configuration Database
	Upgrade a BlackBerry Configuration Database
	BESMgmt.cfg properties

	Install the BlackBerry Enterprise Server on a new computer and upgrade the existing BlackBerry Configuration Database
	Specifying a name for the BlackBerry Administration Service pool during the installation process

	Move user accounts to a new BlackBerry Enterprise Server using the BlackBerry Administration Service
	Prevent the previous BlackBerry Enterprise Server from connecting to the BlackBerry Infrastructure
	Start the new BlackBerry Enterprise Server

	Upgrading the BlackBerry Enterprise Server using the cutover upgrade process and create a BlackBerry Configuration Database
	Create a BlackBerry Configuration Database
	BESMgmt.cfg properties

	Install the BlackBerry Enterprise Server on a new computer and create a new BlackBerry Configuration Database
	Specifying a name for the BlackBerry Administration Service pool during the installation process


	Upgrading the BlackBerry Enterprise Server software in phases
	Upgrade multiple BlackBerry Enterprise Server instances in phases
	Upgrade a standalone BlackBerry Router

	Postupgrade tasks
	Restore the BlackBerry MDS Connection Service configuration files
	Upgrade the BlackBerry database notification system
	Best practice: Running the BlackBerry Enterprise Server
	Configure support for Unicode languages
	Configure support for Unicode text in calendars on BlackBerry devices in a Microsoft Exchange 2003 environment
	Configure the BlackBerry Administration Service instances in the pool to communicate across network subnets
	Log in to the BlackBerry Administration Service for the first time
	There is a problem with this website's security certificate
	Configuring BlackBerry MDS Integration Service high availablility during the upgrade process
	Install a BlackBerry MDS Integration Service pool in an upgraded environment

	Change applications to support BlackBerry MDS Connection Service failover
	Configuring support for new attachments
	Configure an upgraded BlackBerry Enterprise Server to support new attachment extensions
	Configure an upgraded BlackBerry Attachment Service to support new attachment distillers

	Assigning an IT policy to a group
	Remove an IT policy from a user account

	Restrict database permissions for the BlackBerry Attachment Service
	Configuring minimum Microsoft SQL Server permissions for the Windows account
	Configure minimum Microsoft SQL Server permissions for the Windows account

	Configuring a computer for monitoring
	Configure the SNMP service for monitoring
	Configure the BlackBerry Monitoring Service to monitor a BlackBerry Enterprise Server


	Troubleshooting the BlackBerry Enterprise Server upgrade process
	Failed to write License Key to the Database
	Previous version detected but no database available
	You encounter errors when you try to upgrade the BlackBerry Configuration Database
	You cannot resolve errors that occur when you move users
	A third-party tool did not install and the BlackBerry Enterprise Server setup application closed
	The BlackBerry Collaboration Service does not connect to Microsoft Office Live Communications Server 2005
	The setup application did not prompt you to change or confirm the MAPI profile
	The BlackBerry Monitoring Service cannot monitor events
	Restore a BlackBerry Configuration Database
	Users experience unexpected behavior with message lists and calendars on BlackBerry devices
	Various BlackBerry Enterprise Server components do not start
	You cannot access the BlackBerry Administration Service
	You cannot create a user account in the BlackBerry Administration Service
	The BlackBerry Administration Service pool name is the same as the FQDN of the host computer

	Glossary
	Provide feedback
	Legal notice

